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Setup Notes

The following information should be used to guide the instructor in the setup of the CAMEO

Stand Alone Training Course.

It is recommended that there is one computer per student (2 students per computer at a
maximum).  The instructor will require a computer as well as an overhead projection device (e.g.,
LCD panel) and screen.  Slides for overheads are included in the training course as individual
PowerPoint  slides, located within the appropriate sessions.  The instructor will need to
photocopy these slides onto transparencies prior to the beginning of the course.  Each computer
will need to have the CAMEO, MARPLOT, and ALOHA application installed and running.
Each computer will also need a "File Manager" program.  The room where the training is held
should be set up like a normal classroom.

CAMEO is available on two platforms: Microsoft Windows and Apple Macintosh.  For a
Windows®-based system, CAMEO requires Windows 3.1, 95, or NT, 40 MB of hard drive disk
space, 8 MB of RAM, and an IBM-compatible PC with a 486 processor.  For the Macintosh
platform, CAMEO requires {to be completed}.

There are two documents associated with this course of instruction.  The CAMEO Stand Alone
Instructor Manual contains a training course outline as well as script notes and detailed script that
are interspersed within each training session.  Script notes are abbreviated course instructions for
every session.  They would be used by the instructor as a quick reference guide after becoming
very familiar with the detailed script.  The script notes are followed by detailed script that is
intended to cover the course in detail and is suitable for an instructor who is not familiar with the
CAMEO Stand Alone application and training materials.  The detailed script may contain
PowerPoint slides and talking points or just text that would accompany a CAMEO demonstration.

The second document used in this training is the CAMEO Stand Alone Student Workbook.  This
workbook contains background information, exercises, course materials, and other useful
information for the student's reference.  Each student needs a copy of the CAMEO Stand Alone
Student Workbook.



CAMEO Stand Alone Training Course Outline

Script Notes for Session I

Day One

I.  CAMEO Introduction (8:30-8:45 am)

Trainers and class introduce themselves. Class members will be encouraged to discuss
reasons for using CAMEO and to identify specific problems that CAMEO could be used
to address.

Using a series of PowerPoint slides, trainers will explain what each student should be
able to accomplish using ‘Little’ CAMEO by the end of the course.  During this opening
session, trainers also will assess class members’ level of awareness/experience with
CAMEO as well as MARPLOT and ALOHA.

Introduction
•  Course Overview
•  Objectives
 

 What is CAMEO?
•  CAMEO Components
•  CAMEO Answers Questions
 



Welcome to this introductory course on CAMEO.  Over the next three days, you
will be introduced to CAMEO, which stands for Computer-Aided Management of
Emergency Operations.  We assume that everyone here has a basic
understanding of Windows™, but that most of you have either never used
CAMEO before or are only just becoming familiar with it.  Before we start, my
name is ______ .  (Give brief introduction of yourself, past history in using
CAMEO and in providing training, if applicable.)
I’m curious about your awareness or experience with CAMEO.  With a show of
hands,

•   How many of you are from local agencies (which ones)?  From state
agencies (which ones), from Federal agencies (which ones), other agencies
(which ones)?
•   How many of you have used CAMEO before?
•   How many have used CAMEO for emergency planning?  For emergency
response?
•   How many of you have used CAMEO’s chemical database?

Great! Now let me tell you what we’re going to be doing in this course.

CAMEO® 3-Day
Training Course

Computer-Aided Management of
Emergency Operations



Over the next three days, we’ll cover most things you need to know to be adept
in the use of CAMEO.  Today, you’ll learn about the basic concepts and functions
of the CAMEO system, and get an opportunity to practice its use.  Tomorrow,
we’ll begin with a brief refresher, provide a demonstration of CAMEO’s query
commands, and then ending with a brief overview of the interaction between
CAMEO and other related programs.  On the last day, we’ll learn how to perform
a hazards analysis and cover some advanced concepts.

Course Overview

● Learn basic concepts and functions of
the CAMEO system

● Provide demonstration of query
commands and overview of CAMEO’s
interaction with other programs

● Learn how to perform a hazards
analysis and cover some advanced
concepts



In this class, you will learn the basic CAMEO functions so that you will feel
comfortable using the program.  Through demonstrations and exercises, you will
learn how to use CAMEO in order to access the chemical database and other
modules.  The program also allows you to determine and plot vulnerability zones
from chemical releases and conduct a hazards analysis.

Finally, you will be introduced to the interaction between CAMEO and the other
software applications that we will briefly describe such as MARPLOT® and
ALOHA®.

Objectives

● At the end of the CAMEO introductory
course, you should be able to:
» Comfortably maneuver around CAMEO

» Use the chemical database and be familiar
with CAMEO’s modules

» Perform a hazards analysis

» Understand relationship between CAMEO
and other software applications



CAMEO is a set of software applications that was developed for use by chemical
emergency planners and responders.  In particular, CAMEO is widely used in
response by fire departments and in planning by State Emergency Response
Commissions (SERCs), Tribal Emergency Response Commissions (TERCs),
Local Emergency Planning Committees (LEPCs), and industry to comply with the
requirements of the Emergency Planning and Community Right-to-Know Act
(EPCRA) (otherwise known as Title III of the Superfund Amendments and
Reauthorization Act of 1986).  CAMEO includes information and software that
directly related to planning and community right-to-know requirements.  CAMEO
includes information databases on chemicals and Census information, as well as
modules allowing the user to enter local information concerning storage and
transport of hazardous chemicals.

What is CAMEO?

● CAMEO is computer software primarily
used:
» For chemical emergency planning

» For chemical response; and

» For regulatory compliance (e.g., SARA
Title III (EPCRA), OPA, RCRA)



The overall CAMEO system is actually a suite of three separate, integrated
software applications.  One component, also named CAMEO, is composed of
information modules and a chemical database in which the user enters local
information.

ALOHA, or the Areal Locations of Hazardous Atmospheres, is an air dispersion
model that allows the user to estimate the characteristics of a chemical release to
air and map the distribution of an airborne contaminant, based on actual
atmospheric and release conditions.

MARPLOT, or the Mapping Applications for Response and Planning of Local
Operational Tasks component, is the mapping application.  MARPLOT allows the
user to plot information on area maps, using either electronic maps developed
from the U.S. Bureau of the Census Tiger™/Line files (TIGER stands for
Topologically Integrated Geographic Encoding and Referencing System), or
scanned or drawn images.  In other words, MARPLOT allows users to plot
vulnerable zones or facilities on a map that also contains street and other
geographic data such as water boundaries, railroads, hospitals, and schools.

CAMEO Components

● The overall CAMEO system is a suite of
three separate, integrated software
applications:
» CAMEO

» MARPLOT™

» ALOHA®



CAMEO allows the user to answer critical questions as a planner or emergency
responder.

LEPC members can use CAMEO for planning purposes to maintain and retrieve
information about the chemicals stored by facilities in their communities.  And, if
an incident does occur, the user can be reminded of the risks posed to
responders and the community by tapping into the information in the chemical
database provided in the software.

Now that you are bit more familiar with CAMEO’s system, I am going provide
some information about its background.

CAMEO Answers Questions

● What hazards are at this site?

● Where is the hazard located?

● What is the chemical?

● What specific hazard(s) does it present?

● How can the hazard be mitigated?



 Script Notes for Session II
 

 

 Day One
 

 II.  Brief History of CAMEO (8:45-9:15 am)
 
 Learning objectives:  To ensure that the class understands the needs that CAMEO was
designed to fulfill.
 

 A PowerPoint presentation will accompany the trainer’s lecture for this session.
 

•  Who developed CAMEO
•  Why CAMEO was developed
•  Navigating CAMEO



In this section, I’m going to provide a brief history of the development of CAMEO,
its relationship to the CAMEO suite of applications, and an overview of its
capabilities.  Hopefully, this overview will help you understand why CAMEO
works the way it does.

Brief History of
CAMEO’s Development



Based on the Agency’s experience in responding to releases, NOAA HAZMAT
recognized that information management is a key problem and significant barrier
to effective responses by first responders.  Thus, CAMEO was initially developed
by NOAA as a response tool, to help responders by providing them with a quick,
complete source of information about chemicals.  Since 1988, EPA’s CEPPO
and NOAA have worked together to develop and augment CAMEO to assist
emergency planners, as well as enhancing CAMEO’s capabilities to assist
response.  The Bureau of the Census and the U.S. Coast Guard have also
collaborated with EPA and NOAA in the effort to continue improvements.

Who developed CAMEO?

● Developed by:
» EPA’s Chemical Emergency Preparedness

and Prevention Office

» NOAA’s Hazardous Materials Response
and Assessment Division

● In collaboration with
» U.S. Department of Commerce’s Bureau of

the Census

» U.S. Coast Guard



Who uses CAMEO?  Anybody who is interested in chemical emergency
planning, response, and preparedness.  Many SERCs, TERCs, LEPCs,
emergency responders (such as fire departments), emergency planners, and
chemical facilities use CAMEO as a chemical information tool.

EPA/CEPPO has been reaching out to LEPCs to ensure that CAMEO is an
effective tool for their use. CAMEO can be used by LEPCs as an information
management tool.  CAMEO can also help them improve their level of emergency
preparedness.

CAMEO was developed for:

● SERCs, TERCs, and LEPCs

● Emergency responders

● Emergency planners

● Chemical facilities



Based on a nationwide survey of CAMEO users, CAMEO was used for multiple
purposes, even by individual users.

• As shown in the above chart, almost 80% of CAMEO users employ the software
for emergency planning.  The same percentage says that they use CAMEO for
emergency responses.

• CAMEO is often linked to Local Emergency Planning Committees.  Almost 70%
say they use CAMEO to support activities of their LEPC.  Not as many, but still a
majority, or 57%, use CAMEO to “manage the facility chemical inventory data”
from EPCRA (the Emergency Planning and Community Right-to-Know Act).
That usage usually overlaps with LEPC support.

Major Uses of CAMEO
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• Based on the same survey, about half of the organizations now using CAMEO
are fire departments.  In fact, CAMEO is used on mobile units like fire trucks.
Another third of the organizations using CAMEO are described as emergency
planning and/or emergency response units.  Thus, these two types alone account
for 8 out of 10 CAMEO users.

• The remaining 20% of all users are scattered among a diverse assortment of
groups.  As shown in the above chart, 6% of the user base is comprised of
chemical facilities.  Examples of other organizations include environmental
organizations, colleges and schools, military and Coast Guard, and police
departments.

• While none of these users are identified primarily as working for a Local
Emergency Planning Committee (LEPC), over two-thirds of the organizations use
CAMEO to support their local LEPC.

Type of Organization Using
CAMEO

Fire 
Department

48%

Chemical 
Facility

6%

Other 
Organizations

14%Emergency 
Planning/
Response

32%

Fire Department

Emergency
Planning/Response
Chemical Facility
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This is the entry screen that the user sees upon entering the CAMEO system.
Each of the 12 modules in CAMEO is displayed under the File menu.  We will be
discussing all of the modules in further detail during the course.  But for now, we
will go ahead and briefly describe each module:

• The Chemical Information module displays the detail records from CAMEO’s
Chemical Database and Response Information Data Sheets (RIDS).

• Within the Facilities module, you can store information on facilities reporting to a
Local Emergency Planning Committee.

• The Chemicals in Inventory/Transit module maintains a record of chemical
inventories and chemicals in transit at facilities in the community.

• The Storage Locations module is a subset of the information in the Chemical in
Inventory/Transit module specifying storage location of chemicals within a facility.

• Within the Screening and Scenarios module, you can perform hazard analysis
on accidental releases of locally stored hazardous chemicals.

• The Toxic Release Inventory module stores information from annual toxic
chemical release reports filed by facilities in the area mandated under Section
313 of SARA.

Navigating CAMEO



 Script Notes for Session III
 

 

 Day One
 

 III.  Chemical Information Module  (9:15-10:00 am)
 
 Learning objectives:  To understand more fully what information is contained in the
Chemical Database and from where it originates.
 

 A PowerPoint presentation will accompany the trainer’s lecture for this session.
 

 Chemical Records (“Codebreaker”)
•  Description of chemical
•  Trade names
•  ID numbers
•  Regulatory information
•  Labeling conventions
 

 RIDS
•  Description of chemical
•  Fire and health hazards
•  Recommendations for fire/non-fire response
•  Protective clothing for responders
•  First aid information
 

 Edit/add/remove records
 

 How the Database is put together
•  Sources of information
•  Ranking of sources
•  Definition of a chemical
 

 

 Break (10:00-10:15 am)
 



 

CAMEO Chemical
Information Module
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The CAMEO Chemical Information Module is composed of two linked databases:
CAMEO’s Chemical Database and the Response Information Data Sheets
(RIDS).

The first database, CAMEO’s Chemical Database, contains more than 4,000
chemical records and approximately 50,000 synonyms, trade names, and other
names.  Each record contains name, formula, and code information about the
chemical, as well as, regulation information and hazards analysis information.
This database is also known as the “Codebreaker”.

Response Information Data Sheets or RIDs provide detailed response
information about hazardous chemicals.  For example, a firefighter could use the
CAMEO’s RIDs information to determine how to respond if he arrived at the
scene of a tanker truck accident which resulted in a spill of nitric acid, a fuming
liquid.  The RIDs information will tell the firefighter how to respond to the spill and
ensure the safety of the firefighter and the public.

CAMEO links records in CAMEO’s Chemical Database to corresponding records
in RIDS.  CAMEO’s Chemical Database acts as an index for RIDS.
 Let’s look with more detail at each of these databases.

Chemical Information Module

● Contains Two Databases in Module
» CAMEO’s Chemical Database

» Response Information Data Sheets (RIDS)

● Establishes Links between the
Databases
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We are looking at the entry screen for the chemical chlorine in CAMEO’s
Chemical Database.  The database contains information on more than 4,000
records.  Each chemical entry contains the following information about the
chemical:

The common name of the chemical, as you can see on this chemical record,
the common name of the chemical is chlorine;

The source of the chemical record, chemical records may be entered by the
user, NOAA, or EPA (NOEPA).

The National Fire Protection Administration codes for flammability (F),
reactivity (R), and health hazards (H)
• The NFPA codes have a ranking system:

– 0 = little hazard to health, low flammability or little reactivity with water or
other solvents.  Higher ranking represent an increased hazard.

– 4 = highest hazard in all three categories.
– S = designates special hazards posed by certain chemicals.
– No water = means that the chemical is unusually reactive with water.
– Oxidizer = indicates that the chemical is a strong oxidizer.
– Corrosive = the chemical is corrosive to living tissue.

 Required DOT label for chemical, the shipper must display DOT label on shipped
packages, railroad tank cars and tank trucks (in 49 CFR § 172).

Chemical Database:  Page 1
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Identification Information
• The United Nations number, this number was established under the UN
Classification System and is used by the US DOT.
• The Chemical formula, this formula is used by American Chemical Society.
• The Chemical Abstract Service registry number, this identification number
assigned to this chemical by American Chemical Society.
• The CHRIS code, which is used by US Coast Guard to identify individual
chemicals, is included in the CHRIS manual.
• The Standard Transportation Commodity Code, a chemical identification code
used by the Association of American Railroads.
• Synonyms, or other commonly-used names for the chemical.
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This slide shows the second page of the Chemical Database record which
contains a new bottom half of information.  For chlorine, this includes the
following:
• Information about how the chemical is regulated; and
• Information used in a hazard analysis.
• The following fields containing regulatory information and information used in
hazards analysis will be shown on the second page of each chemical record:
• - The CERCLA check box indicates if a chemical is listed as a hazardous
substance under CERCLA (40 CFR § 302).
• - The 313 check box indicates if a chemical is on the list of about 300 toxic
chemicals covered under Section 313 of EPCRA.
• - The Resource Conservation and Recovery Act of 1976 Yes/No section.  If Yes,
the chemical is listed as a hazardous substance under RCRA.
• - Regulatory Names under which chemical is regulated are displayed in scrolling
field at the bottom of the record.
• - The CAA 112(r) Check box.  If checked, chemical is listed as toxic or
flammable substance in Clean Air Act, Section 112(r).
• - Threshold Quantity (in Clean Air Act), the threshold storage amount
established by EPA.  When stored quantities exceed this amount, facility
becomes subject to accidental release prevention provisions of Clean Air Act.
• - Extremely Hazardous Substance (EHS) check box, if checked, chemical is an
EHS chemical, i.e., identified by EPA as acute inhalation toxic threat (in Title III of
EPCRA). An Extremely Hazardous Substance Threshold Planning Quantity (in

Chemical Database:  Page 2
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40 CFR § 355) indicated the threshold at which the facility must meet emergency
planning requirements, as listed in Title III of EPCRA.
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This slide is the first slide for the Response Information Data Sheet for the
chemical chlorine.  You can access the RIDS by clicking on the RIDS button
located on the Chemical Information Database record.  The RIDS is an excellent
source of response information, including data regarding the chemical’s
properties and toxicology.  By clicking on the radio buttons, you can view
information about chemicals that includes the following:
• General description;
• Properties;
• Health hazards;
• First aid;
• Fire hazards;
• Fire fighting;
• Protective clothing;
• Non-fire response; and
• Chemical profiles.

We are looking at the general description screen that includes information
pertaining to the general appearance, behavior, and toxicity of the chemical.  It
tells us that chlorine is a greenish yellow gas with a pungent suffocating odor.
Let’s look at what information is in the other radio buttons, like properties.

Response Information Data
Sheet (General Description)
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The properties screen describes the physical properties, flammability limits, and
toxic thresholds.  From this screen we can determine the boiling point for chlorine
is -29 degrees Fahrenheit.  This tells us that Chlorine is a gas at ambient
temperatures.  This information could be useful to a local planner.

Properties
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The health hazards screen describes the specific toxic effects of a chemical.  The
Health Hazards RIDS information is helpful for responders and planners in
assessing the risks to populations in the vulnerable zone (or potential vulnerable
zone) surrounding a facility.  A local planner or responder may be concerned if
chlorine is transported on a local route because it is poisonous and possibly fatal
if inhaled.  Contact with chlorine should be avoided because it may cause burns
to the skin and eyes.

Health Hazards
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The first aid screen describes response recommendations.  If someone came in
contact with chlorine, they would need to know that the onset of side-effects
might be delayed.

First Aid
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The fire hazard screen describes the flammability of the chemical, including
byproducts that may be produced if the chemical is burned.  This screen also
describes any risk of explosion associated with the chemical.  Although we found
out earlier that chlorine is not flammable, this screen goes on to tell us that
chlorine may ignite other materials.

Fire Hazards
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The fire fighting screen includes recommendations for chlorine incidents in which
the fire is involved.  This screen warns responders to evacuate an area that is
endangered by chlorine gas.  This screen also provides some initial information
on the protective clothing to be worn while responding to a release of chlorine.
The next screen will give us more information about personal protective
equipment that needs to be used when responding to a release of chlorine.

Fire Fighting
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The protective clothing screen in the RIDs provides the CAMEO user with the
breakthrough times or safety hints for using common materials in protective
clothing.  If a responder went into an area endangered by chlorine gas, wearing a
suit of Viton, they would be protected from skin contact for up to three hours.
There are other precautions listed on this screen which can tell responders the
steps they need to take in order to protect themselves.

Protective Clothing
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The non-fire response information covers recommendations for chlorine incidents
not involving fire.

Non-fire Response
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CAMEO’s Chemical Database is compiled from several sources, with the source
of each entry cited.  These sources, in addition to providing planners with
additional sources of information, also assist responders, who frequently insist
upon multiple sources of information for these crucial facts. The priority of the
different sources is weighted.  For example, if different names for a chemical
appeared in various references, EPA/NOAA’s:
• First preference is to adopt the chemical name used in the Title III List of Lists
(USEPA 1988);
• Second preference is to use the chemical name from Title 49 of the Code of
Federal Regulations;
• The third preference is to use the chemical name found in the U.S. Department
of Transportation 1990 Emergency Response Guidebook.

Sources of Information

● CAMEO’s Chemical Database sources:
» Title III (List of Lists)

» 49 Code Federal Regulations

» U.S. Department of Transportation

» Association of American Railroads

»  U.S. Coast Guard

» Chemical Abstract Service Registry

» National Institute for Occupational Safety
and Health
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Script Notes for Session IV
 

 

 Day One
 

 IV.  CAMEO Companion Applications, Modules and Menus (demonstration)
(10:15-11:00 am)
 
 Learning objectives: To introduce students to CAMEO applications, modules and menus.
Students will be given a broad overview, with explanations, of CAMEO’s architecture
and capabilities to add structure and perspective to their learning process.
 
 A PowerPoint presentation will be used to introduce students to this subject.
 
 Companion Applications
•  CAMEO
•  MARPLOT
•  ALOHA
 
 Twelve Information Modules
 

•  Chemical Information - The Chemical Information module displays the detail
records from CAMEO’s Chemical Database and Response Information Data Sheets
(RIDS).

•  Facilities - Within the Facilities module, you can store information on facilities
reporting to a Local Emergency Planning Committee.

•  Chemicals in Inventory/Transit - The Chemicals in Inventory/Transit module
maintains a record of chemical inventories and chemicals in transit at facilities in the
community.

•  Storage Locations - The Storage Locations module is a subset of the information in
the Chemical in Inventory/Transit module specifying storage location of chemicals
within a facility.

•  Screening and Scenarios - Within the Screening and Scenarios module, you can
perform hazard analysis on accidental releases of locally stored hazardous chemicals.

•  Toxic Release Inventory - The Toxic Release Inventory module stores information
from annual toxic chemical release reports filed by facilities in the area mandated
under Section 313 of SARA.

•  Incidents - The Incidents module stores information on accidental releases of
hazardous substances.

•  Contacts - The Contacts module maintains a directory of names, telephone numbers
of people or organizations associated with hazardous materials emergency response
or planning.

•  Special Locations - The Special Locations module emphasizes locations of high-
density, confined, or sensitive populations for evacuation in emergency situations.
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•  Resources - The Resources module contains information about groups that may be
helpful in an accident involving hazardous materials.

•  Routes - The Routes module includes information on specific routes used in transport
of hazardous materials.

•  Census Data - The Census Data module is comprised of information collected in the
1990 Census of Population and Housing about people living in all counties of the
USA and its territories.

 
 Menus
•  File - The File option accesses the various modules, manages the printer and exits

CAMEO.
•  Edit - The Edit option performs basic editing.
•  View - The View option allows the user to view information in several fashions.
•  Record - The Record option access various detail records and functions in the opened

module.
•  Utilities - The Utilities option accesses system administration functions you may not

use everyday.  These functions include linking chemicals, running a hook, or
importing and exporting data.  These functions are more advanced and will not be
explained in this course.

•  Window - The Window option allows you to perform standard Windows
manipulation to better view the information.

•  Help - With the Help option, you can retrieve information about the modules, menus,
or installing CAMEO.

•  Sharing - The Sharing option accesses ALOHA, MARPLOT, and CAMEO’s Site
View Planner.

 
 Site Plan Viewer - CAMEO’s Site Plan Viewer is a tool for organizing pictures of floor
plans of facilities and special locations.  You can also link these floor plans to CAMEO’s
Facilities module to help responders in times of emergency.
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This session will introduce you to CAMEO companion applications, modules, and
menus and describe the structure of CAMEO so you can learn the best ways to
use CAMEO.

The CAMEO Suite is composed of CAMEO and its companion applications,
MARPLOT, and ALOHA.  Think about the applications as three file cabinets side
by side that perform separate functions but can share information if the cabinets
are opened at the same time.

The CAMEO system, itself is divided into twelve information modules which
conveniently categorize information to enable emergency planners to effectively
prepare for chemical accidents and emergency responders to quickly respond to
accidents.  Think of the modules as being folders that categorize information in
the CAMEO file cabinet.

All these modules contain menus that enable the user to perform data functions.
Think of these menus as the things you do when you look at the module files;
such as copy, view, or edit.

The CAMEO system also contains the Site Plan Viewer.  This accessory actually
embeds a blueprint of a facility into the Facilities module.  This feature is very
effective during emergencies, enabling responders to visualize a facility and
where chemicals are stored.
 

CAMEO Companions,
Modules, and Menus

● Companion Applications
» CAMEO

» MARPLOT

» ALOHA

● Twelve Information Modules in CAMEO

● Menus

● Site Plan Viewer
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Let’s briefly discuss the applications or the “file cabinets” of the system.  CAMEO
is composed of databases on chemicals.

In a survey conducted in February 1997, the feature which users considered
most useful in CAMEO was the extensive RIDS database.

CAMEO is a very powerful tool, however it does have its limitations.  Though the
CAMEO chemical database includes over 4,000 chemicals, there are over
60,000 chemicals in use in the United States.

 

“Little” CAMEO

● “Little” CAMEO has an extensive
database with specific emergency
response information for over 4,000
chemicals.

● Limitations
» Expand and update the chemical database

» Simplify and broaden the importing and
exporting of data
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MARPLOT is a mapping application used to plot facilities and sensitive
populations on electronic maps.  The application allows users to create, view,
and modify maps.  In addition, the application allows users to link information
entered into CAMEO to a map.

The practicality of MARPLOT stems from the ability to plot information on
CAMEO files including ALOHA footprints, scenarios, facilities, schools, and
Census data.
 

MARPLOT

● General-purpose mapping application of
objects and Census data

● Links objects on maps to data in
CAMEO and other programs
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ALOHA is a modeling tool used for evaluating hazardous chemical release
scenarios.  The tool determines the pollution concentrations downwind from the
source of the release considering the specific toxicological and physical
characteristics of the released chemical as well as the specific circumstances of
the release scenario.

ALOHA can be integrated with CAMEO information and with MARPLOT to map
the ALOHA-calculated plume areas.
 

ALOHA

● ALOHA is an air dispersion model used
to evaluate hazardous chemical release
scenarios

● ALOHA can work with CAMEO
information and MARPLOT mapping
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•  Chemical Information - The Chemical Information module displays the detail
records from CAMEO’s Chemical Database and Response Information Data
Sheets (RIDS).

•  Facilities - Within the Facilities module, you can store information on facilities
reporting to a Local Emergency Planning Committee.

•  Chemicals in Inventory/Transit - The Chemicals in Inventory/Transit module
maintains a record of chemical inventories and chemicals in transit at facilities
in the community.

•  Storage Locations - The Storage Locations module is a subset of the
information in the Chemical in Inventory/Transit module specifying storage
location of chemicals within a facility.

•  Screening and Scenarios - Within the Screening and Scenarios module, you
can perform hazard analysis on accidental releases of locally stored
hazardous chemicals.

•  Toxic Release Inventory - The Toxic Release Inventory module stores
information from annual toxic chemical release reports filed by facilities in the
area mandated under Section 313 of SARA.

•  Incidents - The Incidents module stores information on accidental releases of
hazardous substances.

•  Contacts - The Contacts module maintains a directory of names, telephone
numbers of people or organizations associated with hazardous materials
emergency response or planning.

CAMEO Modules

● Chemical
Information

● Facilities

● Chemicals in
Inventory/Transit

● Storage Locations

● Screenings &
Scenarios

● Toxic Release
Inventory

● Incidents

● Contacts

● Special Locations

● Resources

● Routes

● Census Data
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•  Special Locations - The Special Locations module emphasizes locations of
high-density, confined, or sensitive populations for evacuation in emergency
situations.

•  Resources - The Resources module contains information about groups that
may be helpful in an accident involving hazardous materials.

•  Routes - The Routes module includes information on specific routes used in
transport of hazardous materials.

•  Census Data - The Census Data module is comprised of information
collected in the 1990 Census of Population and Housing about people living
in all counties of the USA and its territories.
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As you can see, the modules are intricately entwined.  Rather than trying to
explain the relationship to you, it would be better to describe the individual
modules and highlight the links.  The remainder of the training course will do
exactly that.  This course will explain CAMEO’s architecture and capabilities.
Don’t worry about remembering this because the slide is simply a visual depiction
of the Show Links feature within the Records menu.  Within a module, you can
select another module if the name is highlighted within the Show Links feature.
 

Module Relationship

Toxic Release
Inventory

Chemicals in
Inventory/Transit

Storage
Locations

Chemical
Information

Facilities

Screening &
Scenarios

Incidents

Special
Locations

Contacts

Routes

Resources

Census Data
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Now let’s briefly discuss the menus.  The menu bar highlights the eight options
used for data and system functions.  The menu items include File, Edit, View,
Record, Utilities, Window, Help, and Sharing.

You can display pull-down menus by clicking a menu name, for example, utilities.
You can also hold down <ALT> and press any of the highlighted or underlined
letters such as U for Utilities.

Once shown, the menu options underneath can be accessed.  Menu items with a
triangle indicate available sub-menus.   The PowerPoint slide depicts a typical
menu option with hierarchical or submenus.
A brief description of each menu option should make you more comfortable with
performing data and system functions.

CAMEO is divided into 12 modules allowing the user to organize information
needed to manage emergency planning and response.  These modules allow for
easy access to many functions within the system.  Information that pertains to
your community can be added to all modules.  You will be introduced to a brief
summary of these modules.  In addition each of these modules will be described
in further detail this afternoon and tomorrow morning.
 

Menus

● File

● Edit

● View

● Record

● Utilities

● Window

● Help

● Sharing
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The File option accesses the various modules, manages the printer and exits
CAMEO.

The Edit option performs basic editing.

The View option allows the user to view information in several fashions.

The Record option accesses various detail records and functions in the opened
module.

Menus (cont.)

● File:  Allows access to various modules,
manages the printer and exit CAMEO

● Edit:  Performs basic editing

● View:  Views information in several
fashions

● Record:  Accesses various detail
records and functions in the opened
module
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The Utilities option accesses system administration functions.  These functions
include linking chemicals, running a hook, or importing and exporting data.
These functions will not be covered in this beginning course.

The Window option allows you to perform standard Windows manipulation to
better view the information.

With the Help option, you can retrieve information about the modules, menus, or
installing CAMEO.

The Sharing option accesses ALOHA, MARPLOT, and CAMEO’s Site View
Planner.

Menus (cont.)

● Utilities:  Perform basic system-level
administrative tasks

● Window:  Perform standard Windows’
manipulation

● Help:  Retrieve help information

● Sharing:  Access ALOHA, MARPLOT,
and CAMEO’s Site View Planner
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CAMEO’s Site Plan Viewer is a tool for organizing pictures of floor plans of
facilities and special locations.  You can also link these floor plans to CAMEO’s
Facilities module to help responders in times of emergency.  The Site Plan
Viewer will be described in greater detail tomorrow morning.

The next session will be a hands-on application of basic navigation skills.
 

Site Plan Viewer

The blueprint for the Green Valley Water Facility 
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 Script Notes for Session V
 

 

 Day One
 

 V.  Basic Navigation Skills (demonstration and hands-on) (11:00-11:30 am)
 

 Learning Objectives:  To train students in basic skills for navigating CAMEO menus and
modules.  Students also will be introduced to the concept of links and how to use these
for navigating.  In combination, these elements will provide students with a fundamental
understanding of the relationship between CAMEO menus and modules.
 
 The trainer will demonstrate basic skills for navigating CAMEO menus and modules, as
well as use of links for navigating.  Students will follow along, using the application.
 

 Starting CAMEO
 

 Beginning Navigation Skills
•  Browse Window

− Access the browse window
− Searching for the appropriate row

•  Detail Window
− Perform basic data entry and editing
− Buttons found with a typical detail window

 

 Show Links
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Detailed Script for Session V

Day One

V.  Basic Navigation Skills (demonstration and hands-on) (11:00-11:30 am)

1) Starting CAMEO
Now that you have been introduced to CAMEO’s program history, architecture, and
capabilities; you will now be trained in basic navigational skills.  To begin CAMEO:

Display Windows’ Program Manager window.  Then open the CAMEO Windows
Program Group and click on the appropriate icon.

The CAMEO login dialog box is then displayed.

In the User Name field, type “rapid,” but don’t type anything in the Password
Field.  Click OK.

You now have access to the CAMEO system.

Note: CAMEO always opens to the File menu displaying the module listings.

2) The Browse Window
This session we will be learning how to navigate through the CAMEO system using the
browse and detail window.  The browse window is the screen that is displayed when
opening any CAMEO module.  This window is an inventory of the available records
within the module.  The window contains a series of rows available for your selection.
Using the horizontal arrows at the bottom of the browse window can access additional
fields not immediately seen.

Under the File menu, open the Chemical Information module by highlighting
Chemical Information.

The browse window lists records available in the active module.  The browse window
also displays most of the data fields for each record.  Records are displayed in rows and
their corresponding data fields are displayed in columns much like a spreadsheet.

Once the module’s browse window has been accessed, you can use the mouse or
keyboard to scroll through and access any record.  For example, let’s find acetaldehyde in
the Chemical Information module.

There are several different methods to search for the appropriate row:
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Click the mouse over the vertical scroll bar or use the Up and Down keys, or
accelerate your search by using the Page Up and Page Down keys on your
keyboard to scroll through a group of listings.

As you may have noticed, scrolling down the chemical database can be very time
consuming.  Because CAMEO has a database containing over 50,000 chemical names,
scrolling is not the most efficient means of chemical retrieval.
 

You could also find the chemical by pressing <Ctrl-F>, typing the chemical
name, and clicking Find.

Browse windows are used to display the results of database searches as well.

CAMEO also has features called Quick Chemical and Query that allow for a more
structured search, thereby saving time and effort.  These features will be described in
greater detail this afternoon and tomorrow afternoon.

Once you have found acetaldehyde, you can display the detail window by double-
clicking on the browse record (the name of the chemical) or by highlighting the
browse record and pressing the Enter key.

Detailed window of acetaldehyde in the Chemical Information module.

3) The Detail Window
For every record shown in a browse window, there is a corresponding detail window.  In
the detail window, you can perform basic data entry and editing and access additional
information.  Buttons found within a typical detail window include:
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a) Two-page detail windows provide a button that accesses the desired page.
b) RIDS button displays the Response Information Data Sheets for the selected
chemical.

Access the RIDS information, by clicking on the RIDS button.

As you can see, the detail window provides a good deal of information concerning any
chemical. Look through the available information by clicking on the radio buttons.

Press the Cancel button to return to the detail window.

c) You can also obtain information from the Comments and User Fields buttons.

Access the Comments information, by clicking on the Comments button.

As you can see, there is currently no information available under this particular field.
However, you will learn how to enter information in the following sessions.

Press the Cancel button to return to the detail window.

To clear the screen of unwanted module information, press Escape on your
keyboard.

This will take you to the Chemical Information browse window.  By pressing Escape
again, you will be taken to a blank screen.

4) Show Links
From any point in the CAMEO system, the user can obtain information from other
modules.  These links provide easy access to specific information without having to
search the entire database.

Open the Incidents browse window by highlighting Incidents under the File menu.
Remain on the “Valve Leak 7/21/95-Green Valley Water Facility” row and
highlight the Show Links item under the Record menu.

Only four modules, Chemical Information, Facilities, Contacts, and Routes are linked to
the Incident module.  This can be determined by noticing the bolded or non-gray names.

Highlight Chemical Information.  You now have specific information on the type
of chemical that leaked from Green Valley Water Facility.  Press Escape on your
keyboard to return to the browse window.

Another example of a link will be shown in the afternoon in the Chemicals in
Inventory/Transit Module.
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Having learned about navigating within CAMEO, we will now introduce you to
CAMEO’s toolbar used as a shortcut to specific data functions.
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 Script Notes for Session VI
 

 

 Day One
 

 VI.  CAMEO Tools and Toolbar (demonstration and hands-on) (11:30-11:45 am)
 

 Learning objectives:  Having learned about CAMEO’s architecture and how to navigate within
it, students will be introduced to the 18 tools and associated toolbar that accompany CAMEO.
 

 The trainer will explain and demonstrate CAMEO tools and toolbar functions.  A PowerPoint
presentation will accompany the trainer’s lecture for this session.
 

•  CAMEO tools
•  Toolbar, with corresponding icons
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Detailed Script for Session VI

Day One

VI.  CAMEO Tools and Toolbar (demonstration) (11:30-11:45 am)

1) CAMEO tools
In this session, you will be introduced to the 18 tools and associated toolbar that accompany
CAMEO.  You will learn to activate these tools.

Open the Chemical Information Module by highlighting Chemical Information under the
File menu and find sulfuric acid by any of the methods you have just learned.

Once you have opened the detail window, the toolbar is located at the top of the window.  Notice
the line of icons at the top of the window.  These are tools and together they make a toolbar.  The
toolbar is always displayed in the same position on the screen.  Leave this detail window open
for next session.

(Note to the instructor: Please proceed to the PowerPoint presentation on the toolbar icons.)
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CAMEO’s toolbar is only available when a detail window is displayed.  You can use the
toolbar for quick access to frequently used features and applications.

To differentiate between menu items, hold down the left mouse button over the icon,
and CAMEO describes the function in the lower left-hand corner of your screen.  To
activate a menu item, simply click on the appropriate icon.

Note:  You must use a mouse to choose buttons of the Toolbar.  You cannot use the
keyboard.

The first four toolbar icons represent items in the Record menu that will allow you to
access detail records.

CAMEO Toolbar

•First Detail Record

•Previous Detail Record

•Next Detail Record

•Last Detail Record
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The paper with the corner folded down represents Add Detail Record.  Clicking on the
icon displays a blank record so you can add a detail record to the active module.

The pencil icon allows you to edit the existing detail record in the active module.

The icon for deleting a detail record is the trashcan.

The magnifying glass icon allows you to find records within the active module.

To move from detail window to browse window, simply click the icon represented by a
spreadsheet.

Cameo Toolbar (cont.)

•Add

•Edit

•Delete

•Find

•Browse
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The binoculars icon enables you to access CAMEO’s more complex Query function.

To perform simple searches or queries click on the filter icon to find all detail records
that meet your search criteria.

To perform simple data functions such as save, cancel, or close active windows, click
on the diskette, slash mark, or CLOSE icon, respectively.

Note:  The important feature of the Cancel icon is that it stops operation in midstream if
a mistake has been made.

Cameo Toolbar (cont.)

•Query

•Find All

•Save

•Cancel Changes

•Close
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The first four icons on the slide allow you to open the Site Plan Viewer, or other CAMEO
components (ALOHA and MARPLOT), and the RIDS database, respectively.

The last button represented by a question mark is the Help icon.  Pressing this icon
prompts you to the Help window for information on any module of the CAMEO suite.

Note:  As you become more familiar with the CAMEO toolbar, you will notice that some
icons do not light up in particular modes.  This means that the icon is inaccessible.  For
example, try clicking on the toolbar’s Save button on your screen.  Nothing happens.
The Save icon is only accessible in the Add or Edit mode.

We will now begin to incorporate the icons in the toolbar into our next session on Basic
Data Entry.

Cameo Toolbar (cont.)

•Site Plan Viewer

•MARPLOT

•ALOHA

•RIDS

•Help
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 Script Notes for Session VII
 

 

 Day One
 

 VII.  Basic Data Entry Skills (demonstration and hands-on) (11:45-12:15 pm)
 
 Learning Objectives: Students will be trained in basic data entry skills for CAMEO.  This
session completes preparatory training for CAMEO - encompassing program history,
architecture, capabilities, and navigation - and ensures a common foundation to support
more sophisticated training during the remainder of the course.
 

 The trainer will demonstrate basic skills for entering data into CAMEO.  Students will
learn how to activate the tools and toolbar as they follow the trainer through this section.
Students will follow along, using the application.
 

 Data Entry
•  Basic Entry (Add, Edit, Delete)
 

 The Tier II Form
•  Accessing the Tier II-Facility Information data entry windows
 

 

Lunch (12:15-1:15 pm)
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Detailed Script for Session VII

Day One

VII.  Basic Data Entry Skills (demonstration and hands-on) (11:45-12:15 pm)

1) Data Entry
In this session, you will be trained in basic data entry skills for CAMEO.  This will
ensure a common foundation to support more sophisticated training during the remainder
of the course.

CAMEO allows basic data entry when any detail record is active.  A user can add, edit, or
delete a detail record by using the Records menu or by using the CAMEO toolbar.
Remember we had selected sulfuric acid in the last session.  Let’s say we want to add a
synonym of sulfuric acid.  To do this:

In the Chemical Information detail window for sulfuric acid, click the Add button
in the toolbar to display a blank data entry window.  Press Add near the
Synonyms box to enter a synonym for sulfuric acid.  Enter “dihydrogen sulfate.”
After entering the information, press the Tab key to complete the procedure.  You
can save your information by pressing the Save button in the synonym box,
however in this case press Cancel to not save.  Press Cancel in the toolbar to exit
out of the adding mode.  You can then press Escape on your keyboard until you
reach a blank screen.

Note: In the adding or editing mode, you can not press Escape to exit out of that mode.
You must press Cancel on your toolbar.

2) The Tier II Form
As another data entry exercise, let’s enter Tier II information.  To access the Tier II-
Facility Information data entry window:

Open the Facilities browse window, remain on Abalone Press, click the View
menu, and then click Tier II form.

The Tier II data entry is a replicate of the Federal Tier II form required under SARA.
You can use this form to generate Tier II forms required under EPCRA.

Click on the Chemical Information Form button at the bottom of the screen to
display the Tier II-Chemical Information data entry window cascaded with the
Tier II-Facility Information data entry window.

You may add information into any of these windows, however in the interest of time:
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Press Close on the Tier Two-Chemical Information window or Escape on your
keyboard and repeat for the Tier Two-Facility Information window to return to
the Facilities module. Press Escape again to return to a blank screen.

Tier Two-Chemical Information window cascaded with the Facility Information
window

Note:  Tier II data entry windows are only accessible when Facilities-related modules are
active.

We will now take a lunch break until 1:15 pm.
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 Script Notes for Session VIII
 

 

 Day One
 

 VIII.  Chemical Information Module (demonstration and hands-on) (1:15-2:00 pm)
 
 Learning Objectives:  To provide students more comprehensive instruction on the kinds
of information stored in the CAMEO Chemical Information module, how the module
works, and how the information can be used and operated on.  Actual scenarios will be
used to illustrate the importance of accurate interpretations.  Students will learn hands on
how to access this information.  This session builds upon the morning (preparatory)
lecture on CAMEO modules.
 

•  Instructor demonstrates use of database
•  Quick Query (Carbon Monoxide)
•  Instructor Example (Hydrogen Fluoride)
•  Instructor Example (Unknown synonym)
•  Student Exercise (Azinphosmethyl)
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Detailed Script for Session VIII

Day One

VIII.  Chemical Information Module (demonstration and hands-on) (1:15-2:00 pm)

During this session, instructor covers, in greater detail, the kinds of information stored in
CAMEO’s Chemical Information module, as well as where to find and access the
information.  Students will follow, using the application, to conduct a Quick Chemical
Query.

Students will watch as the instructor demonstrates.

1) Chemical Information Module
You will notice that when you first start CAMEO, it will automatically select the
Chemical Information option from the File menu.

Click on the Chemical Information option to enter the Chemical Information
Module.

2) Entry screen
Now you will see the entry screen for the module.  The Chemical Information window
contains records for the over 4,000 chemicals in CAMEO’s chemical database.

3) Searching using Quick Chemicals
To find out more information about chemicals found in the CAMEO chemical database,

click the View menu and then click Quick Chemicals.

You will be prompted by a dialog box to enter information about the chemical you are
searching for,

in the box for chemical name, type in carbon monoxide.

You may choose to enter complete names, numbers, formulas, or labels if you have that
information for a chemical.  Or, if you are unsure, you can enter fragments of
information, such as "carbon,” as your search criteria.

Click on Run.

The Chemical Information window will display a list of chemicals relevant to the search
parameters you entered,
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Make sure that carbon monoxide is highlighted and double-click on it to view the
Chemical Information detail window.

The text bar along the bottom of the screen will tell you the number of chemical records
the Quick query found.  Once you have double clicked on the selected record for carbon
monoxide, you will be at the first screen of the Chemical Information detail window.
The record will show you the common name of the chemical as well as other synonyms
and codes used to identify the chemical.

What is a synonym for carbon monoxide?

Yes, carbon monoxide is also known as carbon monoxide, cryogenic liquid (DOT).  You
can find out a lot more information about a chemical, just try clicking to view page 2.

Click on the page 2 button,

Let’s see what we can find out about carbon monoxide, it’s extremely flammable.  Well,
here’s where the Response Information Data Sheets come in handy.

Click on the RIDS button.

Now that we are viewing the RIDS information for carbon monoxide, we can find out
about the fire hazards associated with carbon monoxide.

Click on the radio button for Fire Hazards.

(Instructor reads from record on fire hazards.)  We have learned about the fire hazards of
carbon monoxide, now we should look into fire fighting precautions.

Click on the radio button for Fire Fighting.

(Instructor reads from record on fire hazards.)  Now that you have seen a sample of the
information contained in CAMEO’s Chemical Information Module, I’d like to give you
the opportunity to try it out for yourself.

Click cancel and then go to the Windows menu and select the Close All Windows
option.  Make sure all students are at the blank entry screen.

4) Instructor Example (Hydrogen Fluoride)
Now that we are familiar with using Quick Chemicals, I am going to outline a scenario
and walk through the way in which I would obtain more detailed response information.
There has been an accident at a rail and highway crossing, a truck, carrying cylinders of
hydrogen fluoride, was hit by a passing train.  The train had begun to slow down, but two
cylinders were dislodged from the truck and have struck the ground and begun to leak.
Let's say we are part of the local fire department HAZMAT team, who will be responding
on the scene.  What information would we like to know before we arrive.  It will be
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important to find out the properties of hydrogen fluoride since we know the chemical
involved in the accident.  We should also take note of the current weather conditions
since the tanks have begun to leak.  We need to determine the extent of the area affected
by the leaking chemical.

After entering CAMEO, go to the file menu and select the Chemical Information
option.  Once you have entered the Chemical Information module, select Quick
Chemicals from the View menu.

This should sound familiar from our earlier search for carbon monoxide.  If we know the
name of a chemical Quick Chemicals is a fast and easy way to access the detail record for
the chemical.  If you know less about the chemical in questions, the Quick Chemicals
module is also helpful because you can enter fragments of information that you might
know.

Enter hydrogen fluoride in the chemical name section of the Quick Chemicals
screen and press the run button.

We are given quite a few hits for hydrogen fluoride. We will select the first record on
hydrogen fluoride and begin to determine the response issues and precautions for this
incident.

Press enter to view the detail record.

From the entry screen we decide to go to the RIDS information for hydrogen fluoride.

Press the RIDS button on the entry screen.

Just by looking at the general properties screen we find that hydrogen fluoride is shipped
as a liquid or liquefied gas.  But, we also see that it boils at 67 degrees Fahrenheit.  This
poses a new concern because it is a warm fall day with temperatures in the 80s.  We
realize that we will be dealing with a leaking gas rather than a liquid when we arrive at
the scene.  While this example touches on only a few aspects of response information that
can be obtained from the Chemical Information module, it demonstrates how it can be
used as a quick source of important response information.

5) Exercise (Unknown synonym)
Now let's look at an example that is not quite as straightforward.  We know that we are
often faced with the task of responding to a release when the exact material released is
unknown.  While this may make it more difficult, we can use whatever information we
known in order to identify the material released and to determine the best response plan.
The CAMEO Chemical Information module is useful because we can enter fragments of
information in a Quick Chemical query and obtain a list of chemicals that most closely
match our description.
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I am going to demonstrate how we might obtain chemical information when we know
only an unrecognizable synonym.  A local fire department is called to the scene of a
release, there is a leaking canister marked "trilene," this does not sound familiar.  The
scene of the release is close to a park with a playground where children play and you
want to determine the nature of the chemical released.

Click on the View Menu and click on Clear Quick Chemicals.  Click on the
Chemical Information Module and then select Quick Chemicals from the View
menu.

Since you are not familiar with trilene you enter it in the name field of the Quick
Chemicals module and hope that you get a response which fits this name.

Type trilene in the Chemical Name box in the Quick Chemicals module and press
the "run" button.

The Quick Chemicals screens shows one record for trilene.

Press enter, or double click on the record for trilene.

You are now in the detail record for trichloroethylene.  As you can see, trilene is a
synonym for trichloroethylene.  The Quick Chemicals module can be very useful when
you are provided with incomplete information.  The next step to take would be to look at
the detail record for trichloroethylene and to go into the Response Information Data
Sheets for trichloroethylene to determine the most safe and effective response practices
and measures.

6) Exercise (Azinphosmethyl)
I am going to give you a scenario and I would like you to answer a few questions for me.
You are a local planner and there is a facility that stores pesticides in your town.  This
factory stores azinphosmethyl, which is used as a pesticide.  What might be some
concerns that a local planner would have if there was a release at this facility?

NOTE:  If students are having difficulty, remind them to use the quick query screen to
find the chemicals and to look at the RIDS for potential problems and response
considerations.

The students should take note of the general properties of the chemical, the response
precautions for fire and non-fire responses, the protective clothing to be worn in a
response, as well as the associated health hazards.
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 Script Notes for Session IX
 

 

 Day One
 

 IX.  Facilities Module (2:00-2:15 pm)
 
 Learning objectives:  The trainer will discuss the kinds of information stored in
CAMEO’s Facilities module, as well as where to find and access the information.
 

 

Break (2:30-2:45 pm)
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The Facilities Module can be used to keep track of basic information about
facilities where hazardous chemicals are manufactured, stored, and processed.
A separate record could be created for each facility or for each department or
division within a large facility.  Each facility record should contain basic
information, such as location, address, contacts, ownership, type of business,
and size.

The Facilities Module provides a checklist of regulatory provisions each facility
may be subject to.

The Facilities Module contains links to data in several other CAMEO modules,
including the Storage Locations Module, the Chemical Inventory/Transit Module,
the Contacts Module, and the Routes Module.  The Facilities Module tracks
available records contained in these other modules.

Finally, the location data stored in the Facilities Module can be used to mark the
location of facilities on maps in MARPLOT.  MARPLOT mapping features will be
discussed later.

Facilities Module

● Tracks basic information about facilities

» Address

» Contacts

● Provides check list of relevant regulations

● Tracks information from other modules
● Marks locations of facilities on MARPLOT

maps
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Right now we are looking at the first page of the Abalone Press record in the
facilities module.  This page contains basic information about the facility including
the address, phone numbers, and contacts.

Facilities Module Cont’d
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The second page of the facility module detail record provides the CAMEO user
with greater detail about the facility.

For example, we can find out if the Abalone Press stores EHS chemicals on site?
You can see that this facility does not store EHS chemicals on site.

We may want to know if the facility submits release and inventory reports for TRI
under EPCRA 311, 312, and 313?  Looking at page two of this record, we see
that the facility submits release and inventory reports for TRI under EPCRA 311
and 312.  We know this because the TRI reporting box is checked.

Facilities Module Cont’d
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Script Notes for Session X
 

 

 Day One
 

 X.  Chemicals in Inventory/Transit Module (demonstration and hands-on) (2:30-
3:15 pm)
 

 Learning objectives: To provide students more comprehensive instruction on the kinds of
information stored in the CAMEO Chemicals in Inventory/Transit module, how the
module works, and how the information can be used.  Students will learn hands-on how
to access and perform operations on this information.  This session builds upon the
morning (preparatory) lecture on CAMEO modules.
 

 The trainer will discuss, in greater detail, the kinds of information stored in CAMEO’s
Chemicals in Inventory/Transit module, as well as where to find and access the
information.  Students will follow, using the application. The trainer will guide students
through examples of basic operations (e.g., add, edit, remove, search) on the data using
skills learned during the morning session.  Finally, the trainer will guide students through
a sample query to illustrate a practical exercise using this information.
 

 Records-List of chemicals stored at a facility
•  To access the Chemicals in Inventory/Transit module
 

 Edit/add/delete/search records
 

 Facility query
•  Checking CAMEO’s Chemical Database for an entry
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Detailed Script for Session X

Day One

X.  Chemicals in Inventory/Transit Module (demonstration and hands-on) (2:30-
3:15 pm)

1) Records-List of chemicals stored at a facility
This session, you will learn about the Chemicals in Inventory/Transit Module.  Let’s first
look at the list of chemicals stored at a facility.  Under Sections 311 and 312 of Title III
of SARA, annual inventories of certain on-site hazardous chemicals that exceed certain
amounts must be reported.  The Chemicals in Inventory/Transit module is used to enter
information about a facility’s chemical inventory.  The information within this module is
related to a facility or route already entered in the database.  Once entered, the
information is maintained in Tier II reports for facilities reporting under Title III.

The module also maintains an inventory of chemicals stored at each facility.  Information
can be included about storage method, quantities on-site, and physical state of each stored
chemical.

To access the Chemicals in Inventory/Transit Module:

Click the File menu and then click the Chemicals in Inventory/Transit.  CAMEO
displays the module’s browse window.

The window gives the chemical names in alphabetical order and the facility/route where
the chemical is located. The route or facility might be there several times if it has more
than one chemical.

Activate the Green Valley Water Facility detail window by clicking onto the
appropriate name.

This detail window contains information on storage amounts, storage locations, and
hazards of the chemical located within the facility.  This detail window informs us that
chlorine is inventoried as a pure gas in the Green Valley Water Facility.

2) Edit/add/delete/search records
Now let’s explore editing, adding, and deleting records.  Oftentimes selected chemicals
will already be in CAMEO’s Chemical Database.  To enter a chemical name in this detail
window:

Click the Add button in the toolbar to display a blank data entry window once the
detail window has been accessed.
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Notice that a menu for the Facility/Route name pops up.  This menu indicates whether the
information is directly related to the Facility or Route modules already in the database.
Therefore, you must add information into these modules before accessing the Chemicals
in Inventory/Transit module.  However in this case, let’s use the “Abalone Press Facility”
by clicking on Select.

Using the Tab key or mouse, place the cursor in the Chemical Name field.
Type hydrochloric acid and press Enter.

CAMEO asks for further clarification about the name.  Do we want hydrochloric acid,
hydrochloric acid mixture, or hydrochloric acid solution.

Highlight hydrochloric acid and click Select.

What we have just done is to say that hydrochloric acid is inventoried at the Abalone
Press facility.

Chemicals in Inventory/Transit added detail record of hydrochloric acid

If we wanted to, we could add additional information such as the maximum amount of
hydrochloric acid at the facility, the physical state of the chemical, and the storage
locations.  To add additional information about storage locations:

Press Add in the Storage Location Field.

CAMEO prompts you to the Storage Locations menu.  This menu includes information
on the storage type, pressure, temperature, and units measured.  These four items offer
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pull-down menus for selection.  However, you can only select conditions available in the
pull-down menus.

Enter “Tank wagon” for Storage Type and “Ambient temperature” for Storage
Locations.  Press the Save button in the Storage Locations window.  Once you
have finished entering data into the Chemicals in Inventory/Transit detail
window, press the disk icon in the toolbar that represents Save.

Note:  If the CAS number and chemical name entered match a CAMEO chemical,
CAMEO creates a link.  RIDS information is then available for this linked chemical.

The RIDS information for hydrochloric acid

Chemical names may not always be in the CAMEO’s chemical database.  Chemicals not
found in the database are not linked to RIDS information.

For example, press Edit Detail Record in the toolbar, which is represented by the
pencil.  Lets type in “dihydrogen sulfate” in the Chemical Name field.

We know from this morning that it’s a synonym for sulfuric acid, however, let’s imagine
that we had not associated the two.

Press Save in the toolbar.

In this instance, there is not a chemical match in CAMEO’s chemical database.  CAMEO
will then display a warning.
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The CAMEO warning displayed when the chemical entry is not found in the
chemical database

If it does not match a CAMEO chemical and you made a mistake in the data entry or it
was not the right chemical, press Escape and re-enter the information; or in our case,
click the OK button to disregard the message and accept the chemical.  CAMEO allows
this entry and you can enter additional information into the other fields.  The chemical is
now unlinked.  The disadvantage with an unlinked chemical is the lack of information
afforded to it.  All the information for the chemical must come from the user.

To edit or delete this record, simply click the Edit Detail Record or the Delete Detail
Record from the toolbar when this detail window is active.

Press Cancel in the toolbar to cancel changes.

Now let's show how you can check CAMEO's Chemical Database for a particular
chemical to add to the Abalone Press facility inventory/transit.

First, click on the inventory/transit menu and double click on Add under the
record menu and again click Abalone Press.  Then, in the Chemical Name box,
type the first several letters of a chemical name.

For example: Enter “hydro” in a blank data entry window once you’ve entered
“Abalone Press” for the Facility/Route name.  Press the Tab key or move your
cursor to another field.

CAMEO will display all chemicals beginning with “hydro.”
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List of chemicals beginning with “hydro.”

Highlight hydrochloric acid and click Select.  CAMEO enters the chemical name
and CAS number in the appropriate fields.  Click the Cancel button in the toolbar
to not save the information.

3) Facility query
Let’s say you wanted to know the chemicals at a particular facility from the
Inventory/Transit module.  You can do it in two ways: directly from the Inventory/Transit
module as you have seen or through the Facilities module linked to the Inventory/Transit
module.  For the latter:

Click the File menu, and then click Facilities.  Activate the Abalone Press
Facilities detail window.  Click the Record menu and then click Show Links.
Once in the menu item, click Chemicals in Inventory/Transit.

This browse window shows the list of chemicals stored at this particular facility.  It is
important to note that you have just recently added the hydrochloric acid entry to this
particular facility.  Now how would you go about deleting this record if the facility was
no longer in use?

Simply select the unwanted record in the browse window and press the Delete
icon, represented by a trashcan, in the toolbar.

CAMEO will ask if you would like to delete this record and all dependent
records.  Press Yes.  You have now deleted the new entry.

Note to the instructor:  This follows the Census data PowerPoint slide.
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1) Show how to import census information

(Students observe, while instructor explains and demonstrates on-screen.)

Census information is stored in the F98.DBF file.  This file is located in the DATA
subdirectory under the directory where CAMEO is installed (e.g.,
C:\CAMEOWIN\DATA).

The National Safety Council can provide the F98.DBF file containing the counties of
your choice.

Alternatively, you can load the F98.DBF file yourself from the LandView CD-ROM
from the U.S. Bureau of the Census.  Use the program F98_LOAD.EXE, located in the
installation directory (e.g., CAMEOWIN), to extract data from the LandView CD-
ROM(s) for your area.

Note that you should NOT be running CAMEO when you execute the
F98_LOAD.EXE program!

a) In Windows, run the F_98.LOAD.EXE program by double-clicking the program name
listed in the Program Manager File menu.

b) At the prompt, specify the drive letter for the CD-ROM containing the census data.
The loading program will be seeking the cen_blkg.dbf, states.dbf, and counties.dbf
database files in the /lv2/ subdirectory.

c) Using the scroll bars, select a state and county name.  We will append this data to the
existing 98.dbf file in CAMEOWIN/DATA, rather than replace the file altogether.  Select
run to complete this action.

d) Using the scroll bars, we can select and append additional counties after loading the
first county.

2) Show how to access and browse the Census Data Module

(Students observe, while instructor explains and demonstrates on-screen.)

Now we’re ready to take a look at how to access, browse, and select data contained in the
Census Data Module.

We can access these data by:

Clicking Census Data on the pull-down File menu.

For a detail view to observe more data fields



76

Double click on a record.

We can use the arrow buttons in the Detail View to move from record to record in the
Census Data Module.  As you learned earlier in this session, each record contains
information for a specific census block group.

Use arrow buttons to move in the Detail View

3) Summarize Census data and use Screening and Scenarios and MARPLOT to
better understand release impacts

(Students observe, while instructor explains and demonstrates on-screen.)

The Screening and Scenarios module calculates a vulnerable zone radius for a chemical
release scenario.  The vulnerable zone can then be plotted on a map using MARPLOT.
The maps in MARPLOT also contain Census block groups.  Wouldn’t it be useful to
combine these capabilities to determine the population potentially impacted by a release?
Let’s do it.

First, go to the Screening and Scenarios module.

Click on Screening and Scenarios in the File menu

Screening and Scenarios includes a screening (worst-case) analysis and another scenario
for the Green Valley Water Facility.  We will look at the second scenario.

Select the second entry in Screening and Scenarios, then click View Detail

As you can see, Screening and Scenarios calculated a vulnerable zone radius of 0.8 miles
for a chlorine release from the Green Valley facility.  Let’s look at the vulnerable zone
for this release on a map.

Click on Sharing, then click on MARPLOT

Click on Show on Map

You can see the vulnerable zone for the release plotted as a circle around the Green
Valley facility.  The Census blocks show up on the map in different colors. To get more
information on the Census groups that might be affected by this release, we must select
them on the map.

Click on a point within the first Census block, then hold down the left mouse
button and drag the pointer into the next Census block

The Select on Layers menu lets us select the Census Block Groups.
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Click on Select, Census Block Groups checked, in Select on Layers

Now you can see the boundaries of the potentially affected Census blocks. We can use
Zoom Out and Zoom In icons to see more of the county or more detail on the affected
area.

Use the zoom icons to show the area

CAMEO will give us additional information about these Census blocks.

Click on Sharing, then click on CAMEO, then Get Information

The two selected Census groups show up on the MARPLOT object list.

 Click on View Detail Screen

Now you can see that the first Census block group has 2,231 people.  You can get a
summary of the Census data for both Census block groups using the “Summarize” button
in the upper right of the screen.

Click on Summarize

As you can see, the summary shows that the combined population of both Census block
groups potentially affected by the Green Valley release is 3,909.  The other Census
information presented here on race, age, and so on, also represents combined data from
both Census block groups.
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 Script Notes for Session XI
 

 

 Day One
 

 XI.  Other Modules (3:15-4:30 pm)
 

 Learning Objectives: To provide students more comprehensive instruction on the kinds of
information stored in other CAMEO modules, how the modules work, and how the
information can be used. The modules will be covered in various levels of detail.  A
PowerPoint presentation will be used to introduce students to the other modules.
 

 The trainer will discuss, in greater detail, the kinds of information contained in other
CAMEO modules, as well as where to find and access the information.
 

 Other Modules
•  Storage Locations
•  Screenings and Scenarios
•  Toxic Release Inventory
•  Incidents
•  Contacts
•  Special Locations
•  Resources
•  Routes
•  Census data
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Other Modules
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This session will provide you with more comprehensive instruction on the kinds of
information stored in other CAMEO modules.  The Storage Locations module is a
subset of the information in the Chemical in Inventory/Transit module.  The fields
in the storage location detail records resemble data fields on Tier II Hazardous
Chemical Reporting Forms.

This module allows the user to enter data about the types of chemicals stored at
a facility, the locations of the chemical within the facility, and the conditions under
which they are stored.

Storage Locations
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CAMEO includes a Screenings & Scenarios module that can be used to perform
hazards analysis calculations recommended in the Technical Guidance for
Hazards Analysis:  Emergency Planning for Extremely Hazardous Substances
published by EPA, FEMA, and DOT in 1987, also known as the “Green Book.”
You can use this module to estimate threat zones by using either Screening or
Scenarios to assess hazards.

The Screenings function allows the user to calculate the size of the area around
a chemical storage facility or along a transportation route that could be affected
by an accidental release of a hazardous chemical.  This area is known as a
“screening zone.”

This function allows the user to calculate the screening zones for facilities that
store Extremely Hazardous Substances (EHSs) above the Threshold Planning
Quantity (TPQ) using the process in Section 3.1 of the Green Book.

The Scenarios function extends the screening capability to allow users to change
the meteorological and chemical parameters, based on actual conditions in the
user’s area.  This more realistic scenario is used to estimate a “vulnerable zone.”

Screenings & Scenarios

● Performs hazards analysis calculations

● Assesses hazards from accidental
releases of hazardous chemicals

● Estimates threat zone by using either:
» Screenings - based on worst case

assumptions

» Scenarios - based on actual conditions in
the user’s area
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This slide shows the results of a calculation for a worst case screening using the
Green Book guidelines.  The user can estimate the size of the threat zone for the
“credible worst case” assumptions, entering weather conditions and other
information that the user believes typify the region and the facility.

In this worst case screening, the entire contents of a chlorine tank or 2000 lbs are
assumed to escape into the atmosphere over 10 minutes.  Under the worst case
screening, which assumes a low wind speed of 3.35 mph, very little atmospheric
turbulence dilutes the chlorine cloud, and, as a conservative estimate of the
chlorine concentration that may cause adverse health effects, the threat zone is
predicted to extend more than 10 miles downwind because no wind direction is
specified. This creates a circular screening zone with a radius greater than 10
miles.

The risk category allows you to indicate the level of exposure to hazards and
helps you to further prioritize hazardous situations.  The subcategories (risk,
consequences, and overall risk of releases) are determined by you using a
qualitative scale of high, medium, or low.  Risk of release is the probability of the
occurrence of a release.  Consequences of release is the extent of the impact of
the spill.  Overall risk of release considers both risk and consequences of
release.

Screenings
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This worst case screening can be used by planners to compare facilities, to
determine which might pose the most significant threat to the community under
this worst case situation.
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This is an alternate release scenario, in which the weather conditions have been
altered to fit the user’s conditions.  In addition, the contents of the tank are
expected to escape over 30 minutes rather than 10 minutes.  With these
changes, including higher winds and a more turbulent atmosphere, which dilutes
the chlorine cloud, the scenario gives a vulnerable zone with a radius of only 0.8
miles, as compared to the radius of over 10 miles that was obtained in the worst
case screening.

We have now worked within CAMEO to see information on chemicals, facilities,
screenings and scenarios.  At this point, the power of the integrated CAMEO
suite of applications can be highlighted.  For instance, using CAMEO’s “Sharing,”
or integration, capabilities, the user can view the vulnerable zone on a digital
map.

Scenarios
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This is the alternate release scenario that we talked about, with a vulnerable
zone for a release of chlorine displayed using MARPLOT, the mapping
component of CAMEO.  We’ll explain more about MARPLOT in a few moments.

If the user is interested in an object within the “vulnerable zone,” he or she can
use the sharing capability to access the information they have entered in the
CAMEO system.  For instance, there appears to be a school located within the
vulnerable zone on the map.  By using the Sharing capabilities with CAMEO, the
user can access any information about the school that they have entered in
CAMEO.

Vulnerable Zone
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The TRI module provides a framework for storing and using TRI information.

You can use the TRI module to:
• Store information from annual toxic chemical release reports filed by facilities
in your area;
• View a facility’s yearly estimate of the facility’s releases of certain toxic
chemicals; and
• Track reports of releases filed by facilities subject to emergency reporting
provisions.

The TRI provides information about both routine and accidental releases of toxic
chemicals to the environment and is required under EPCRA section 313.

Toxic Release Inventory
Module

● You can use the TRI module to:
» Store information from annual toxic

chemical release reports filed by facilities
in your area.

» View facilities’ yearly estimates of their
release of certain toxic chemicals.

» Track reports of releases filed by facilities
subject to emergency reporting provisions.
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You can obtain TRI information from the Right to Know Network website (RTK
Net) at http://www.rtk.net/www/data/tri-gen.html. You can obtain state TRI
information as a text file or preloaded into a TRI module from the National Safety
Council (NSC) by calling (800) 621-7619.  You can also obtain TRI information
as text files from the National Technical Information Service or the U.S.
Government Printing Office.

Obtaining TRI Information

● Right to Know Network (RTK Net)
» (202) 234-8570

● National Safety Council (NSC)
» (800) 621-7619

● National Technical Information Service
(NTIS) or US Government Printing
Office
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This slide shows the information contained in Toxic Release Inventory (TRI)
detail record.  Each TRI detail record contains these fields:
- Shipper check box, indicating if the detail record is for a shipper
- The name of the reporting facility.
- The Department or division of the reporting facility.  If necessary, you can use
several individual records to identify specific locations (or buildings) within a large
facility.
- The Chemical Abstract Number (CAS #) of the chemical released.
- The name of the chemical released.
- The identification number for the facility from Toxic Chemical Inventory
Reporting Form (“R Form” -- release reporting facilities must use).  This number
is assigned by EPA.
- Fugitive releases to air:  the amount of chemical not released through confined
air streams (evaporative losses).
- Stack releases to air:  the amount of chemical released through confined air
streams (stacks, vents, ducts).
- The National Pollutant Discharge Elimination System (NPDES #) permit number
for releases to water for the facility.

Toxic Release Inventory (TRI)
Module
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The Incidents module allows you to keep track of accidental releases of:

• Extremely Hazardous Substances (EHS Chemicals), defined in Title III of
EPCRA

• Hazardous Substances (CERCLA chemicals), defined in CERCLA Reporting
requirements.

This module includes fields for information that facility operators must report
under Section 304 of Title III of EPCRA when there is an incident.  For instance,
the detail window of the Incidents module of Green Valley Water Facility’s
accidental release is shown here.  The first page of the Incidents module displays
information about the location and occurrence of the spill, the reporter, and the
type of material released.

Incidents (Page 1)
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On the second page of the Incidents module, information on the nature of the
spill is displayed.  Categories include source, medium, cause, number of injuries,
number of deaths, property damage, agencies notified and involved.  In a new
record, it also possible to click on the Comments button to include any additional
information about the incident.  Longitude and latitude coordinates can also be
added by clicking on the Map Data button.  Lat/Long information can be entered
in degrees/minutes/seconds (up to 11 characters) in the user Latitude and
Longitude fields.

Incidents (Page 2)
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This is the detail window of the Contacts module.  You use the Contacts module
to keep a directory of names, telephone numbers, and areas of expertise of
people or organizations associated with hazardous materials emergency
response or planning.  If you were to add a contact, the module offers pull-down
choices.  For example under type of contact, you could select from a list including
compliance officer corporate emergency contact, emergency coordinator,
environmental, and others.

You can link Contacts detail records to symbols on a map representing locations
of contact people or organizations.

Contacts
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The Special Locations Module can be used to keep track of the address and
geographical location of special populations, such as high-density, confined, or
sensitive populations that may need special attention during a chemical
emergency.  Such populations typically include schools and hospitals.

In addition, the Special Locations Module can track other basic information on
each sensitive population.  Each record could contain information on contacts,
building type, hours of operation, and size of the population.

The Special Locations Module contains links to data in the Contacts Module.

Special Locations Module

● Keeps track of basic information on
special populations

● Populations
» High-density (e.g., apartments)

» Sensitive (e.g., schools)

● Information
» Address

» Building type
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You can use the Resources module to maintain information related to
companies, persons, or agencies that may provide response resources in the
event of an accident involving hazardous materials.

Resources Module

● Contains resources to contact for
assistance in responding to an
emergency:
» Companies

» Persons

» Agencies
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Examples of response resources that you may choose to list include:  service
companies; heavy equipment operators; or equipment rental companies.

The Resources detail records contain a wide variety of fields:
- The name of the resource;
- A description of the resource type (e.g. Mass communication);
- Amount, a general description of the resource available;
- Locational information including the county, city, state, and zip of the resource;
- The fire district or other political unit within which the resource is located;
- Mailing street address of the resource as well as, city, state, and zip information
for the resource;
- Phones contains key number for the actual site of the resource;
- The contacts scrolling list contains contacts related to the populations site; and
- The date when the record was last modified.

All of these fields will contain useful contact information for use in planning for
and responding to hazardous materials releases in your area.

Resources Module
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The Routes module is used to maintain information about routes used to
transport chemicals.  Route types include air, water, or land.

Data which can be entered into this module include the route name, the amount
of traffic, and whether the route is designated as a snow emergency, school
zone, or mass transit zone.

Screening and Scenarios can be created for chemical in transit over  specific
routes.

Routes
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Data contained in the Census Data Module are used to characterize the
population around facilities for emergency planning and response and for
hazards analyses.  For example, it may be useful to estimate the number of
persons who reside within the vulnerable zone around a facility.

Census Data Module

● Use to characterize the population
around facilities for emergency planning
and response and hazards analysis.
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The Census Data Module contains selected demographic and economic
information collected by the U.S. Bureau of the Census during its 1990 Census
about people living in all U.S. states, counties, and territories.  The Census
information in this module includes:

a) Population characteristics; and
b) Economic and housing characteristics.

Census Data Module

● Contains selected 1990 demographic
and economic census information from
the U.S. Bureau of Census:
» Population characteristics; and

» Economic and housing characteristics.
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Each record in the Census Data Module contains these fields:
a) 4-digit tract number;
b) 2-digit block group number, a term we’ll explain shortly;
c) Total population within the census block group, another term we’ll explain
shortly;
d) Total number of households within the census block group;
e) Total number of families within the census block group;
f) Race distribution by numbers and percentage for Whites, Blacks, Indians,
Asians, Hispanics and Others;
g) Age distribution by numbers and percentage

Census Data Module
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The Census Bureau, for purposes of collecting and analyzing census data,
divides each US County into Census Tracts.  Census Tracts are delineated for all
metropolitan areas and other densely populated counties.  Census Tracts are
small, relatively permanent statistical subdivisions of a county.  Census Tracts
usually have between 2,500 and 8,000 persons and, when first delineated, are
designed to be homogeneous with respect to population characteristics,
economic status, and living conditions.  Census Tracts do not cross county
boundaries.  The spatial size of Census Tracts varies widely depending on the
density of the settlement.  Census Tracts are delineated with the intention of
being maintained over a long time so that statistical comparisons can be made
from census to census.

Each Census Tract is further subdivided into Census Block Groups.  Census
Block Groups are usually small areas bounded on all sides by visible features
such as streets, roads, streams, and railroad tracks, and by invisible boundaries
such as city, town, township, and county limits, property lines, and short,
imaginary extensions of streets and roads.  Census Block Groups are generally
defined so that they contain approximately 400 housing units; thus, depending on
the population density in an area, the sizes of Census Block Groups may vary
widely.

Remember that each record in the Census Data module displays demographic
and economic information about people living within a single geographic unit
within a county called a Census Block Group.

Breakdown of the Census data

● Census Tracts

● Census Block Groups
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CAMEO is not distributed with census data.  The user populates the Census
Data Module with census data relevant to their emergency response and
planning region.

The U.S. Census Bureau distributes census data for all U.S. states, counties,
and territories on the LandView™ III series of CD-ROMs.  LandView III software
is a geographic reference tool, like an electronic atlas.  It stores and displays
EPA-regulated sites, demographic and economic information from the 1990
Census, and key geographic features of the United States.  Each of the 10
LandView CD-ROMs covers a different region of the United States.  An 11th CD-
ROM is a summary.

You can obtain a copy of the CD-ROM for your region from:
a) National Safety Council (NSC); 1-800-621-7619 (or FAX order to 708-285-
07970) or visit their websit at http://www.nsc.org/ghc
b) Customer Services, U.S. Bureau of the Census, Washington, D.C.  20233;
301-457-4100 (or FAX order to 301-457-38429) or visit their website at
http://www.census.gov.

Obtain Census Data

To obtain a copy of LandViewTM III CD-ROM for
your region, contact:

» National Safety Council (NSC):  1-800-621-
7619 (or FAX order to 708-285-0797); or

» Customer Service, U.S. Bureau of the
Census, Washington, D.C.  20233:  301-457-
4100 (or FAX order to 301-457-3842.
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 Script Notes for Session I
 

 

 Day Two
 

 I. Refresher (8:30-9:00 am)
 
 The trainer will review key concepts taught during the previous day and will allow time
to answer any questions that the class may have before proceeding with Day Two agenda.
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 Script Notes for Session II
 

 

 Day Two
 

 II.  Site Plan Viewer (demonstration and hands-on) (9:00-10:00 am)
 

 Learning Objectives:  To explain the site plan viewer and to instruct students on how to
link information from Chemical Information, Facilities, Chemicals in Inventory/Transit,
storage locations, and other CAMEO modules to electronic maps for viewing.
 

 Introduction (PowerPoint presentation)
 

 Viewing storage locations for Green Valley Water Facility
 

 Creating a site plan drawing
•  Editing site plan pages
 

 Using symbols
•  Linking a symbol to a CAMEO Storage Locations detail record
•  Creating and editing your own symbols
 

 

 Break (10:00-10:15 am)
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Detailed Script for Session II

Day Two

II.  Site Plan Viewer (demonstration and hands-on) (9:00-10:00 am)

Note: Instructor begins this section with a PowerPoint presentation.

1) Viewing storage locations for Green Valley Water Facility
Imagine how important it would be for a firefighter during a rescue to know where
particular hazardous chemicals are located in a room.  CAMEO provides the capability
with the Site Plan Viewer. The Site Plan Viewer (SPV) menu is accessed through the
Sharing menu of CAMEO.

Under the Sharing menu, click Site Plan Viewer and then click Go to Site Plan
Viewer.

On a site plan, you can view the storage locations for chlorine at the Green Valley Water
Facility.  Close the Site Plan Viewer by,

Clicking on Close from the File menu.

To view a specific record in the Site Plan Viewer,

click on Storage Locations under the File menu.

CAMEO displays the Storage Locations browse window.

Highlight, but don't double click on the first chlorine storage location record
associated with Green Valley Water Facility.

To view the chlorine storage location, you need to access the SPV.

Click on the Sharing menu, click on the Site Plan Viewer submenu, and then click
Show on Plan.

CAMEO now displays the Green Valley Water Facility site plan record and symbol for
the correct location of chlorine selected.

Let's say you wanted to look up CAMEO's facility information associated with this site.
To do this, first you need to return to CAMEO.

Under the Sharing menu, click on the CAMEO submenu and click on Get Info on
Plan.
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CAMEO displays the Facilities detail window for the Green Valley Water Facility.

2) Creating a site plan drawing
In order to view the floor plans of a facility, CAMEO's SPV uses Windows bitmap files
(*.BMP).  SPV gives you three possible ways to access bitmap files.

•  If you use a scanner to scan site plan pages from paper, save the scanned
images in Windows bitmap format (.BMP).

•  If you receive site plans electronically and the site plans are not in *.BMP
format, use a graphics application to convert the files to *BMP format.

•  If pre-existing site plans are not available, create site plans in almost any
Windows-based graphics program (e.g., Paintbrush).  Save the images in
*.BMP.

[NOTE: Bitmaps are saved at any of four different color resolutions:  monochrome, 16-
color, 256-color, and millions of colors.  The more colors a bitmap file has, the larger the
file – and the more RAM the file requires.  SPV best displays a picture if the bitmap file
is at the lowest necessary color resolution.  On some PCs, SPV may not be able to display
complex files at higher color resolutions.]

To create a new site plan set, begin in CAMEO.  Display the Facilities browse window
by

clicking on File menu and clicking Facilities.

You are interested in creating a site plan for M&S Chemicals, so highlight the facility and
display the facility's detail window.

Under the View menu, click Detail.

In order to see the site plan for M&S Chemicals, you need to click the Site Plan Viewer
submenu of the Sharing menu, and then click Show on Plan.  If the facility is not already
linked to a plan, CAMEO prompts you whether you want to start a new plan set for the
facility.  Because you have CAMEO edit privileges, SPV asks whether you want to start
a new site plan set.  (If you do not have CAMEO edit privileges, SPV displays a message
stating the facility is not linked.)

Click Yes to start a new site plan set for this facility.  Click OK for the edit mode.

When SPV displays the Load New Background Picture dialog box, you can use a sample
site plan in the SPLNBMPS subdirectory of the CAMEOWIN directory.  In this
subdirectory, you have a selection of "grenval1.bmp" and "grenval2.bmp."  You can use
the site plan for Green Valley Water Facility for this exercise.
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Click on the grenval1.bmp file and click OK.

[NOTE TO INSTRUCTOR:  You may create a drawing using Paintbrush or some
other graphical application to use for your example, or use another file if you
have one available.  However, for convenience purposes, we will use one of
Green Valley Water Facility's site plans.]

When you click a bitmap, SPV copies the bitmap and places the file in the SPLNBMPS
subdirectory.  SPV stores all site plan bitmaps in the SPLNBMPS directory.  Once you
select a bitmap, you may move or delete the original bitmap at any time.  After you select
a file, SPV creates the site plan set and displays the CAMEO Site Plan Viewer window
with the first page of the site plan.  Also notice that once you turn on the edit mode, you
will see it indicated underneath the facility name in blue letters, "Edit mode ON."

2a) Editing site plan pages
As you can see, the page displayed is for Green Valley Water Facility.  In order to make
it applicable to M&S Chemicals, you need to edit the site plan.  You can accomplish that
by using your drawing application.  SPV allows you to edit site plan pages by providing a
link to a graphics application of your choice.  To edit the currently displayed site plan
page, click Go to Drawing Application under the Sharing menu.  By default, SPV opens
the Windows' Paintbrush program link.  [NOTE TO INSTRUCTOR:  You may need to
establish your drawing application if it does not automatically come up.  Check
Preferences under the Site Plan menu in the Site Plan Viewer program.  Under the
location of the drawing application, type in the location of the executable file.]  Edit the
file.  For example in the Paintbrush application,

Delete the title of the Green Valley Water Facility by using the eraser function
and then type in "M&S Chemicals" using the text function.

When you are finished, quit Paintbrush and save the file.  SPV displays the updated page.
After you create a site plan, view its corresponding Facilities detail record.  Display the
site plan for which you want to view information.

Click on SPV's Sharing menu, click CAMEO, and then click Get Info on Plan.

CAMEO becomes the active application and displays the facility's detail window.

Now that you are displaying the Facilities record in CAMEO, you can check if the record
is linked to site plan set.  You can do this by viewing its site plan.   Click Show on Plan
from the Site Plan submenu of the Sharing menu.  When SPV opens and displays the first
page of the site plan set for the M&S Chemicals facility, you have successfully linked the
facility to the site plan set.

If you want to delete a picture from a site plan set, you can display the page you want to
delete.  To delete the site plan, you would click the File menu, and then click Delete
Page.  SPV deletes the entire set whenever you use the delete function.
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3) Using symbols
You can place symbols on site plan pages and link the symbols to CAMEO's Storage
Locations detail records or Contacts detail records.

From the previous exercise, you should be in SPV and the edit mode should still be on.
Since the edit mode is on, you should see a Symbol Tools palette with 12 different
symbols.  Generally, if you want to place a symbol on a site plan, you would first select a
symbol by clicking on its button.

Click once on any symbol.  See how the symbol button you selected is now pressed
down.

Then you would position the cursor where you want to place the symbol,

and click the left mouse button.

SPV places a symbol on the site plan at that position.

3a) Linking a symbol to a CAMEO Storage Locations detail record
You can also link a site plan symbol to a CAMEO Storage Locations detail record.  You
can start this linkage from either SPV or CAMEO.

Since we are in SPV currently, let's learn how to link the symbol in this application first.
Click once on the double tanks symbol that is located on the lower right-hand corner of
the palette.  Place the cursor in the lower left-hand corner of the Chlorination Building
and click once.  Four small squares surround the symbol to show it is currently selected.

Select Link Symbol under the CAMEO submenu of the Sharing menu.

CAMEO becomes the active application.  Note the Link to Site Plan menu that is now on
the right-hand side of CAMEO's menu bar.  You want to link the symbol to Storage
Locations, you need to go to the Storage Locations module.

Select Storage Locations under the File menu of CAMEO.

CAMEO now displays the Storage Locations browse window.  You can now select the
storage location to which you want to link the symbol.  For our purposes, highlight the
entry for chlorine at M&S Chemicals.

Select Link to Site Plan menu, and then click Link.

SPV becomes the active application and completes the link between the symbol and the
Storage Locations detail record.  The double tanks symbol is now linked, because you
can see that a yellow chlorine label pointing to the symbol has been placed on the site
plan.
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To learn how to link a symbol starting in CAMEO, you need to go back to CAMEO.  But
before you do that, you need to unlink the symbol in order to be able to link it in
CAMEO.  With the symbol still highlighted,

click Unlink Symbol under the CAMEO submenu of the Sharing menu in SPV.

Once the symbol is unlinked, go back to CAMEO.

Click Go to CAMEO under the CAMEO submenu of the Sharing menu.

You should already be in the Storage Locations module, so highlight the chlorine entry
for M&S Chemicals.  Now you want to see it in SPV, so click on Show on Plan under the
Site Plan submenu of the Sharing menu.  If the storage location is not linked to a symbol,
SPV prompts if you want to link this storage location record to a symbol.  Since this is
the case, click Yes to indicate that you want to link the this storage location now.  SPV
then displays a message that you are in "link mode."  While in "link mode," any new
symbol you place on a site plan page or any existing symbol you select is linked to
CAMEO immediately.

Click the OK button.  Notice that SPV displays a message underneath the facility
name reminding you are in LINK MODE.

You can select an existing symbol or place a new symbol on the site plan to link it to
CAMEO.  In this case, you can use the existing symbol of the double tanks by clicking
on the symbol once.  After clicking on the symbol, you are automatically returned to
CAMEO.  To view whether the link was successful,

Click on Show on Plan under the Site Plan Viewer submenu of the Sharing menu
in CAMEO.

Again, the symbol is now linked and labeled.

After you link a symbol to CAMEO, you can display its corresponding CAMEO Storage
Locations detail record.  Select the double tanks symbol to get information on it.

Click Get Info On Symbol under the CAMEO submenu of the Sharing menu.

CAMEO becomes the active application and displays the Storage Location detail window
for the linked symbol.  A shortcut for this function would be to double-click on the
symbol.

3b) Creating and editing your own symbols
CAMEO's SPV includes a symbol editor that allows you to create and edit your own
symbols.  Access SPV's symbol editor by clicking on any of the symbol buttons with the
right mouse button or double-clicking with the left mouse button.
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At the cursor position, SPV displays a pull-down menu that gives you three options to
edit the Symbol Tools palette - edit this symbol, delete this symbol, and create new
symbol.  Note, you cannot edit or delete any of the stock symbols (the 12 original
symbols).

To create a new symbol,

click Create New Symbol

displays the symbol editor with an empty symbol (i.e., all transparent pixels).

Each square in the large editing box represents one pixel.  You can create a symbol as
large as 16 by 16 pixels.  A gray 'X' in one of the squares in the edit box represents a
transparent pixel.  (You can see the background picture at that pixel location.)

a.  Click on a color in the color selection window.  Click in a square in the edit
box to fill the corresponding pixel with the color.  Hold the mouse button and
drag the cursor to fill adjacent pixels with the same color.
b.  To create a transparent pixel, click the box marked Transparent, then click one
of the squares in the edit box.
c.  The Symbol Editor displays a preview of the symbol in its actual size in the
box marked 'Symbol'.
d.  Click OK.  The new symbol displays in the Symbol Tools window.

Break (10:00-10:15 am)
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CAMEO's Site Plan Viewer (SPV) is a tool for organizing pictures of floor plans of
facilities and special locations, and linking the floor plans to CAMEO's Facilities
module and Special Locations module and Storage Locations module.

Site Plan Viewer
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The SPV offers different functions for the site plan.  You can view, edit, or even
create a site plan of a facility.  When the edit mode is on, SPV offers a number of
symbols that you can use to add detail to your site.  You can also create your
own symbols if necessary.

Edit Mode ON
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You place symbols on site plans to represent locations of stored chemicals, and
link the symbols to CAMEO Storage Locations detail records.  This allows you to:
•   quickly view names and locations of chemicals in a facility; and
•   have quick access to floor plans for emergency planning and response.

Storage Locations
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Detailed Script for Session III

Day Two

III.  Hands-on Exercises (10:15 - 11:00 am)

Learning Objectives:  To "test" the class on their mastery of skills already learned and
new viewing skills, and to allow class members to work together to apply the lessons
learned to actual, simple problems likely to be encountered.

Class members will work together in small groups (2 - 4 people) to answer the exercises,
which will be based upon existing case studies compiled by EPA/CEPPO.  One-half hour
will be allowed for the class to go through the exercises (with assistance from the
trainer(s), where necessary), with an additional 15 minutes allowed for discussion of the
answers and any additional questions the class may have.
Students should try Problem Set 1 in the CAMEO Student Workbook, which consists of:

•  Ten questions and a
•  Data entry exercise.

NOTE:  Instructor, Problem Set 1 and answers follow:
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Problem Set 1 Questions (1 - 10)

1.  What chemical is also known as dichloromethane (a commonly used synonym)?

Answer:  methylene chloride

Steps to follow:
a)  Go to the Chemical Information Module, by clicking on Chemical Information from

the File menu.
b) Go to the view menu and click on Quick Chemicals.
c) In the field for Chemical Name type, "dichloromethane" and click on the Run button.
d) You will see a list of 5 chemicals.
e) Double-click on each chemical to enter the detailed chemical information window

until you can determine the chemical that is also known as dichloromethane.
f) From the View menu click on Clear Quick Chemicals.

2.  If you are searching for a chemical and the only information you have is the following
number, 1701, where should you begin?

Answer:  Search for the number in the UNNO# field, which is a 4-digit code.

Steps to follow:
a)  Go to the Chemical Information Module, by clicking on Chemical Information from

the File menu.
b) Go to the view menu and click on Quick Chemicals.
c) What field might contain a 4 digit number?  You know the CAS Number field must

contain at least 5 digits.  You should begin your search by entering the number in the
UN Number field.

d) From the View menu click on Clear Quick Chemicals.

3.  What is the common name of this chemical?

Answer:  xylyl bromide

Steps to follow:
a)  Go to the Chemical Information Module, by clicking on Chemical Information from

the File menu.
b) Go to the view menu and click on Quick Chemicals.
c) In the UN Number field type, "1701" and click on the Run button.
d) You will see one option, which is xylyl bromide, you have successfully identified the

chemical.
e) From the View menu click on Clear Quick Chemicals.

4.  How many chemicals in the database require the DOT label, "Spontaneously
Combustible"?
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Answer:  46 chemicals in the database require the DOT label, "Spontaneously
Combustible."

Steps to follow:
a) Go to the Chemical Information Module, by clicking on Chemical Information from

the File menu.
b) Go to the view menu and click on Quick Chemicals.
c) In the field for Label type, "Spontaneously Combustible" and click on the Run button.
d) Once CAMEO has finished searching, look at the number of records listed on the

status bar at the bottom of the window.
e) From the View menu click on Clear Quick Chemicals.

5.  What is the "Flash Point" for ethylene glycol?

Answer:  232 degrees Fahrenheit.

Steps to follow:
a) Go to the Chemical Information Module, by clicking on Chemical Information from

the File menu.
b) Go to the view menu and click on Quick Chemicals.
c) In the field for Chemical Name type, "ethylene glycol" and click on the Run button.
d) Once CAMEO has finished searching, click on the first record for ethylene glycol to

enter the detailed chemical information window.
e) Click on the RIDS button to view the Response Information Data Sheet.
f) Click on the Properties button to view the chemical properties of ethylene glycol.
g) Read the Flash Point for ethylene glycol from the Properties screen.
h) Click cancel button on RIDS record.
i) From the View menu click on Clear Quick Chemicals.

6.  What would be the most appropriate protective clothing to wear when responding to a
release of sulfuric acid?

Answer:  For emergency situations, wear a positive pressure, pressure-demand, full
facepiece  self-contained breathing apparatus (SCBA) or pressure-demand supplied air
respirator with escape SCBA and a fully-encapsulating chemical resistant suit.

Steps to follow:
a) Go to the Chemical Information Module, by clicking on Chemical Information from

the File menu.
b) Go to the view menu and click on Quick Chemicals.
c) In the field for Chemical Name type, "sulfuric acid" and click on the Run button.
d) Once CAMEO has finished searching, click on the first record for sulfuric acid to

enter the detailed chemical information window.
e) Click on the RIDS button to view the Response Information Data Sheet for sulfuric

acid.
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f) Click on the button for Protective Clothing to determine what should be worn when
responding to a release of sulfuric acid.

g) From the View menu click on Clear Quick Chemicals.

7.  How many facilities are located in Haymarket?

Answer:  3 facilities are located in Haymarket.

Steps to follow:
a) From the File menu, click on Facilities to enter the Facilities Module.
b) From the Facilities Module, click on the View menu and select the Find All option.
c) From the "Select field to search in:" scroll down menu select Location City.
d) In the "Enter value to search for:" box type, "Haymarket."
e) Check the "Ignore Case" box and leave the "Exact Match" box unchecked.
f) Press enter.
g) Once CAMEO has finished searching, you can read the number of facilities in

Haymarket from the status bar at the bottom of the window.
h) To check your search results, enter the first facility record, Adams Petroleum

Refinery, and look at the city location.  It is in fact Haymarket.

8.  What facility is listed as having Toxic Release information?

Answer:  Green Valley Water Facility.

Steps to follow:
a) From the File menu, click on Facilities to enter the Facilities Module.
b) Press enter to view the detailed facility record for Abalone Press.
c) Once you are in the detailed information window click on the Page 2 button.  On

Page 2 you can find information on whether or not a facility submit Toxic Release
Inventory information.

d) Click on the red arrow on the toolbar to advance to the next record.
e) Continue to go through the facility records, looking at the Toxic Release checkbox.
f) You will see that Green Valley Water Facility has the Toxic Release box checked.

9.  How many chemicals start with the letter "S" and are Extremely Hazardous
Substances?

Answer:  27

Steps to follow:
a) Go to the Chemical Information Module, by clicking on Chemical Information from

the File menu.
b) Go to the view menu and click on Quick Chemicals.
c) In the field for Chemical Name type, "S" and in the field for "EHS (Y/N)" type "Y"

and click on the Run button.
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d) Once CAMEO has finished searching, look at the status bar along the bottom of the
window to read the number of records of extremely hazardous substances, beginning
with the letter "S'.

10.  Looking at the list from the previous question, can you find out what the DOT label
for sodium selenite says?

Answer:  Poison

Steps to follow:
a)  Scroll down the list of chemicals using the arrow keys until you reach the record for

sodium selenite.
b)  Press enter to view the detailed record for sodium selenite.
c)  Look on Page 1 of the detailed record to find the DOT Label field.
d)  Read the DOT Label for sodium selenite, it says, "Poison."
e)  From the View menu click on Clear Quick Chemicals.

Data Entry Exercise

In this exercise you will update the Facility Contact information for the Green Valley
Water Facility.  Imagine that you are an LEPC and you have received a telephone call
from the Human Resources department at the Green Valley Water Facility.  Green Valley
has a new Senior Plant Manager and they wanted to make sure that you had the most
current contact information.  You need to include this new information in your records
for the Green Valley Facility.  You have been given the following information:

Name:   Wong, Angela
Organization:  Green Valley Water Facility
Title:   Senior Plant Manager
Work Phone:   (703) 232-5547
Beeper:   (703) 232-7554

You receive a call from Angela Wong, she reports that Green Valley just received a new
shipment of chlorine.  You need to update your records for the Chemicals in Inventory at
the Green Valley Facility.  You have been given the following information:

Chemical: Chlorine
Amount: (5) 150# cylinders
Storage Location: Tank in Water House
Other: Pure, gas, greater than ambient pressure, reactive, acute, normal

ambient temperature

 Steps to follow:
a)  From the File Menu, select the Facilities Module by clicking on it.
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b)  From the Facilities list use the arrow keys to scroll down and highlight the record
for the Green Valley Water Facility and press enter to view the detailed
information for the facility.

c)  Click on the Add button on the toolbar to enter the new contact information for
the Green Valley Water Facility.

d)  Click on the Add button next to the Contacts information field.  Enter the
information provided above.

e)  Click on the Save button to save your changes to the Contacts information.

Now, to enter the Chemicals in Inventory information.

a)  Click on the Chemicals in Inventory/Transit option in the File menu.
b)  Select the record for the Green Valley Water Facility, press enter to view the

detail record for the facility.
c)  Click on the edit button on the toolbar to enter the information for the new

shipment of chlorine.
d)  In the field for storage locations click on the Add button to enter the new storage

location.
e)  In the pop-up window that appears enter the information from above.
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 Script Notes for Session IV
 

 

 Day Two
 
 IV. CAMEO Query Commands (demonstration and hands-on) (11:00-12:00 pm)
 
 Learning Objectives:  Instructor introduces students to CAMEO Query Commands by
demonstrating how to build a query to answer a sample inquiry.  This session will begin
with slides and end with a demonstration of Query Commands by the Instructor.  Upon
completion, students should be able to:  access the Query Commands, build simple to
moderately complex queries, construct a filter, browse results, print results, and write
results to file.  Students also will learn how to use some of CAMEO’s more advanced
query commands.  Students will have an opportunity to apply the newly-acquired query
skills in the hands-on exercise session immediately following this one.
 
 Introduce CAMEO Query Maker and explain what it is used for
•  To answer a variety of questions related to emergency planning and response

activities.
 
 Demonstration of Query Maker commands
•  Sample query:  Which facilities in Haymarket, Virginia store chlorine?

− Specifying conditions
− Demonstrate how to build a query using CAMEO Query Maker commands:

•  Accessing Query Maker
•  Query List Manager
•  Filter Building dialog box
•  Select Fields to Show in Query
•  Query Overview
•  Select Fields to Sort Records By
•  Run Query
 
 Editing query results
 
 Browsing query results
 
 Printing and writing query results to file
•  CAMEO’s standard report format
•  Wide range of file output options
 

 Show how to use some of CAMEO’s more advanced query commands
•  Expand a simple query
•  Group and summarize
 

 

Lunch (12:00-1:00 pm)
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Information stored in CAMEO’s records and databases can be used to answer a
variety of questions related to emergency planning and response activities.  To
be useful, however, CAMEO must be able to provide comprehensive answers
while excluding information that is not relevant to the immediate inquiry.

CAMEO includes a set of commands, called Query Maker, that enables the user
to do this.  In contrast to the simple Find command, Query Maker allows the user
to build multiple “filters” and search “conditions” -- two terms will will cover in
more detail later during this session.  In addition, using Query Maker, the user
can customize output requirements, such as the format, the fields to include, and
the order in which the desired records are presented.  Finally, Query Maker uses
the relationships between CAMEO’s various databases to enable searching data
stored in databases that are not contained within the same module.

CAMEO Query Commands

● CAMEO Query commands enable you to
answer a variety of emergency planning and
response questions.

● “Query Maker” is a set of query commands.

● Using Query Maker you can set “Filters” and
“Conditions” to obtain data contained in
different modules.
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Each time we build a new query in CAMEO, we use the following sets of Query
Maker commands.

- Query List Manager
- Filter Building
- Select Fields to Show in Query
- Query Overview
- Select Fields to Sort Records By
- Type of Output

I will describe these commands separately as I demonstrate the procedure for
accessing Query Maker and building a query.

Query Maker Commands

● Query List Manager

● Filter Building

● Select Fields to Show in Query

● Query Overview

● Select Fields to Sort Records By

● Type of Output
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In our first example, we will use Query Maker to obtain an answer to the following
question:  Which facilities in Haymarket, Virginia store chlorine?

At the end of the session we will expand this query to use some of CAMEO’s
more advanced query commands.

Sample Query

Question:

Which facilities in Haymarket,

Virginia store chlorine?
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We create a query in CAMEO by translating the query into a set of conditions.

What is a condition?  A condition is a criteria that defines the set of data you are
seeking.  For example, “Facilities: city contains Haymarket” consists of:  a field
name, “city,” from the “Facilities” database;  a relational operator, “contains;” and
a comparison value, “Haymarket.”

In general, each condition you add can narrow the results of the query and vice
versa.  When multiple criteria are specified, conditions can be combined using
AND and OR connectors.  Parentheses also can be used to dictate how
conditions are interpreted.  How you connect and bracket the various conditions
makes a big difference in the results.  We shall see this in some of the exercises
in our next session.

Specifying Conditions

Q:  What is a condition?

A:  A condition is a criteria that defines the
set of data you are seeking.

   field name           comparison value

“Facilities: city contains Haymarket”

relational operator
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2) Demonstration of Query Maker commands
During this session, I will demonstrate how to use CAMEO Query Maker commands to
answer the sample inquiry.  You will have an opportunity to apply what you learn during
the next hour to build an original query during the hands-on exercise immediately
following this one.

(Go to slides.  Students observe, while instructor explains and demonstrates on-screen.)

a) Accessing Query Maker
We can access Query Maker from within any one of CAMEO’s 12 modules.  The fields
for which we can specify search conditions, however, depend upon the module we access
Query Maker from.  For our inquiry, we want to identify all facilities located in
Haymarket, VA that store chlorine.  To specify condition for these two fields, we must
access Query Maker from within the Facilities module.  (Access Facilities module now.)
From within the Facilities module, we choose Query from the Views pull-down menu.
(Access Query command now.)

b) Query List Manager
This opens the Query List Manager screen.  The Query List Manager is Query Maker’s
“control panel.”  It is a screen showing titles of previously saved queries.  These queries
may have been created by you or previously loaded into CAMEO.

Notice that a query named “Facilities in XX City that store YY Chemical” already exists?
Let’s create a copy of the existing query and modify it for purposes of answering our
inquiry.

To do this, click Copy.  When prompted to enter a new query title, we’ll type in
“Example” and click OK.  We can edit “Example” by highlighting its name in the list and
clicking Edit.

c) Filter Building dialog box
The Filter Building dialog box is where you specify a set of conditions.

The query we just created called, “Example,” executes two conditions joined by the
“AND” operator.  Notice that both conditions include the phrase “{To be entered later}?”
Let’s replace this phrase in the first condition with the value “Haymarket” and in the
second with “Chlorine.”  We will retain the fields and operators specified.  Note that
these entries are not case-sensitive.  In other words, the Query command does not
distinguish between upper and lower case letters.

d) Select Fields to Show in Query
To complete creating our query called, “Example,” we need to set the output
requirements.  The first time we Select any query after it has been created, CAMEO will
prompt us to specify these requirements.
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In our example, as in most cases, we won’t need to see every field in the database in the
output.

Using the Select Fields to Show in Query dialog box, we will specify which fields we
want to see after the query has run.  Simply double-click the field names from the list on
the left.  For our example, let’s select the facility name, the chemical stored, the amount
of this chemical that is stored on average, and city in which the facility is located.  Click
OK.

e) Query Overview
This takes us to the Query Overview dialog box.  Notice, along the left column, that we
have already specified a filter and selected output fields.  At this point we also may
specify the type of output and the sort order for the output or run the query in default
setting for one or both of these options.

f) Select Fields to Sort Records By
To illustrate the Sort features, let’s specify an option to sort the output in descending
order based on the average amount of chlorine stored at a facility.  To do this, click the
Edit Sort Order button.  Double-click the “Chemical Inventory:  average amount” field
name from the list.  Since we would like to sort in descending order, click the Sort button
at the bottom.  To sort in ascending order in the future, we need to click the Sort button
one more time to undo our last action.

For now, however, let’s Run the query without setting Types of Output.  We will discuss
this a little later in the session.

g) Run Query
Using the conditions we specified, we learn, in answer to our question, that there are two
facilities in Haymarket storing Chlorine.

3) Editing query results
Next, let’s edit the query we have just created.  Notice, for example, that the field
containing the city name is oddly located in the last column of the table.  Let’s change the
sequence of the output fields and run the query a second time with the city name next to
the facility name.

Before we can begin, however, we must clear the current query by choosing Clear Query
from the View pull-down menu.  Then, once again, from the Facilities module, select
Query from the View pull-down menu.

From the Query Manager List, select the query we just created named, “Example.”
Notice this time that this action takes us directly to the Query Overview dialog box, since
we have already specified filter and output criteria the first time we defined this query.

To change the sequence of the output fields, click the Edit Output Fields button.  Next,
we will click and drag the field name “city” until it appears below the facility name.
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We have finished editing the query, “Example.”  When we run the query this time, we
see that the changes have taken effect.

4) Browsing query results
Because the Browse Query Results box was checked in the bottom right of the Query
Overview dialog box, we are able to browse the outputs on-screen immediately after
running the query.  We do so using the vertical and horizontal scroll bars.

To print a hard copy report containing the results, however, let’s run the query again with
the browse feature turned off.

5) Printing and writing query results to file
Under Type of Output, select CAMEO’s standard report format.  With this option
selected, we can print a hard copy using the print setup dialog box or view the report on-
screen.

In additional, CAMEO offers a wide range of file output options, including FoxPro
database, WordPerfect mail merge, ASCII,  Excel, and Lotus 123 formats.  When writing
results to a file, CAMEO prompts us to specify a file name beginning with the letters
“QMF.”  Since the results are written to CAMEO’s installation directory, this naming
convention prevents us from accidentally overwriting a data or program file being used
by CAMEO.

6) Show how to use some of CAMEO’s more advanced query commands
CAMEO’s more advanced query commands enable us to create forms and customize
query results.

Forms are particularly useful for questions that occur frequently and use the same field
and relational operator; by allowing the user to change the comparison values each time
the query is run, the same query can be used to answer a range of inquiries.

We know from our example above that CAMEO’s output options allow the user to
control the presentation of query results.  CAMEO also can perform simple computations
on the query results without requiring the use of exterior software, such as spreadsheets.

Let’s expand the simple query we just created to take advantage of these more advanced
capabilities.

a) Expand a simple query
Let’s begin by revisiting the query, “Facilities in XX City that store YY Chemical.”
When we select this query from the Query Manager List, CAMEO prompts us to enter a
city name and then a chemical name.  If we enter, “Haymarket” and “Chlorine,”
respectively, we obtain the same two facilities as we would using the query, “Example.”
If, instead, we enter in “Haymarket” and “Naptha,” we obtain a different facility, Adams
Petroleum Refinery.
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In contrast, the comparison values in “Example” are explicit, seeking only those facilities
in Haymarket that store chlorine on-site.  Let’s modify the explicit query in “Example”
into a form that will enable us to seek facilities in any city, storing any chemical.

To do so, we select “Example” from the Query Manager List and edit the Value we
specified in the Filter Dialog box.  Rather than specifying a particular city and chemical
name, we click Ask Later for both of these comparison values.

b) Group and summarize
Sometimes, it is also useful to group and summarize the numerical output.  Building on
the query called “Example,” let’s customize the results to present how much chlorine is
stored on average at all facilities throughout Haymarket, VA.

To do this, we select Edit Output Field and use options available in the Select Fields to
Show in Query dialog box.  In this example, we want Query Maker to cluster information
around the group chlorine, so we highlight “Chem Inv:  Chemical Name” from the list on
the right and click Group.  In the Select Group Field Type dialog box, specify “Group
records first by this field.”  This tells CAMEO to group all output records with the same
Chemical Name together.  For more complex queries, we can group using up to three
different fields.

Next, highlight “Chem Inv:  Average Amount” from the list on the right and click Group.
In the Select Group Field Type dialog box, specify “Sum this field for each group.”  This
tells CAMEO to sum the data in this field for all output records with the same Chemical
Name.

If we run this query, specifying Haymarket for city and chlorine for chemical name, we
find that on average 3000 pounds of chlorine are stored in Haymarket, VA.

Using the Query commands you learned during this session, you will build an original
query in the next session.

Now we will take a lunch break until 1:00 pm.
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 Script Notes for Session V
 

 

 Day Two
 

 V.  Searching the Chemical Database and Other Modules (1:00-2:00 pm)
 

 Learning Objectives:  To access information in each CAMEO module, use a saved query,
Access CAMEO’s Tier II form, and enter data into CAMEO’s Tier II form.
 

 Reviewing basic navigation skills
•  Browse Window
 

 The Query menu item
•  To view the query
•  To create a new query
•  To access the new query
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Detailed Script for Sessions V and VI

Day Two

V.  Searching the Chemical Database and Other Modules (1:00-2:00 pm)

1) Review basic navigation skills-The Browse Window
In this session, we will be reviewing basic navigation skills, working with the Query
menu item, and accessing CAMEO’s Tier II form.

As you remember, the browse window is the screen which is displayed when opening any
CAMEO module.  This window is the entry point to all modules containing rows in
which you can select.  These browse windows can be accessed under the File menu.  We
will use the Chemical Information browse window to explain the Query menu item.

Access the Chemical Information browse window.

2) The Query menu item
Now onward to bigger and better applications.  The query menu item can provide a
specialized view of information in a database.  A query can be developed to sort, group
and summarize records and information.  To view the Query:

Highlight View in the menu and scroll down to Query.

CAMEO then accesses the Query List Manager.
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The Query List Manager

The Query List Manager is the query’s main window.  This screen lists the previously
saved queries.  These queries may have been created by you or may be previously loaded
into CAMEO.  As you can tell, nothing has been saved thus far.  Data functions can be
performed on existing queries by the buttons located at the bottom of the Query List
Manager.

To create a new query you can develop one from scratch or you can modify an existing
one.  To create a new query from scratch:

Press the Add button in the Query List Manager.  Now you are asked to enter a
new query title.  Once you’ve entered the title “Chemicals,” you will be asked to
complete a number of steps.  In Step 1: Pick a field by locating Chemical Name
and pressing Enter.  You will then be prompted to Step 2 which determines the
specifications regarding the chemical name.  Pick “Begins with or matches” by
pressing Enter.  In Step 3, enter the comparison value as “hydro” and press OK.
Again press OK to exit and save changes.

You will then be prompted to the Filter Building dialog box.
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The Filter Building dialog box for our conditions.

You must remember that every query is an attempt to extract a subset of information
contained within your database system.  The Filter Building dialog box is where you
specify a set of conditions to determine the subset you are seeking.  This set of conditions
is your filter.

Note: You can access this dialog box from the Query List Manager by pressing the Add
or Edit button if there is an existing query.

Your query is designed to search for chemical names beginning with the letters “hydro.”

If satisfied with the query press OK and return to the Query List Manager.
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Creation of a new query.

To access the query:

Click Select on the Query List Manager.

You will be presented with an information screen on using the field picker dialog.  Click
OK.  You can then select fields.  It should be noted that you must pick at least two fields
to include in the query.

For this example, select Chemical Name and CAS # by clicking on them.  Press
OK at the bottom of the window to proceed to the Query Overview dialog box.

Note: You can also access this dialog box by highlighting an existing query in the Query
List Manager and pressing Select.
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The Query Overview dialog box for our query.

You can use the Query Overview dialog box to:

a) Review or change your record filter by using the Edit Record Filter button.
b) Select which fields to show in the query output in the Edit Output Fields
button.
c) Select what type of report or output to generate in the Type of Output button.
d) Run the query with the Run Query button.

You have now specified what you are looking for within the condition of the query.

We will accept the records filter and press Run Query.
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The results of the query.

You have now performed an advance search query.  You can now access the Chemical
Information in any of the rows.  In addition, you can create a report of the query.

Press Escape on your keyboard.

You will be prompted to the Output Query dialog box.  If you would like a report of your
query, press Yes.  The next dialog box allows you to customize and print your report.

However, in this case Press Cancel to return to the Query Overview Dialog Box.
Then press Escape until you reach a blank screen.

We will now divide you into groups and give you an opportunity to try a hands-on query.
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VI.  Hands-on Exercises - Query (2:00-2:45 pm)

Script Notes for Session VI

Day Two

VI.  Hands-on Exercises - Searching the Chemical Database (2:00-2:45 pm)

Learning objectives: To give the class an opportunity to test their comprehension of the
various search methods, and to allow class members to work together to apply the lessons
learned to actual, simple problems likely to be encountered.

Class members will work together in small groups (2-4 people) and follow the
instructor’s demonstration for the first one-half hour.  An additional 15 minutes will be
allowed for discussion of the answers and any additional questions the class may have.

The Find menu item

The Find All menu item

The Quick Chemical menu item

The Query menu item

Break (2:45-3:00 pm)
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Detailed Script for Session VI

Day Two

VI. Hands-on Exercises - Query (2:00-2:45 pm)

In this session, we will be reviewing basic search methods and demonstrating the
differences associated with the Find, Find All, Quick Chemicals, and Query menu items
in a series of hands-on exercises.

1) The Find menu item
 The Find menu item can perform a quick search but finds only the first record that
matches your criteria.  This menu item searches for the first record that begins with the
text you enter.  To illustrate this point, let’s try an example.
 

 After entering the Chemical Information module, go to the View Menu and click
on Find.  You can then enter the text in the search entry.
 

 You may specify a data field using the Select Field to Search In pull-down menu.  Upon
selecting this pull-down menu, you will notice that there are five fields.  For this
example, use the Chemical Name field.  Although the Chemical Name field is the most
practical, the Preferred Chemical Name ? field searches for true chemical names or
synonyms.  The remaining fields may not be practical for searches.  For example, the
Data Source field contains only one option “NOEPA” in the Chemical Information
module.  Also, the Preferred ID # and Record Identification # fields are assigned
specifically to CAMEO and are not universally known. Besides the five search fields, the
Find menu item offers several functions; including Ignore Case, Exact Match Only, and
Count.  The Ignore Case check box will ignore any capitalization.  The Exact Match Only
check box will search for a record with an exact match rather than the first record that
begins with the text you enter.  The Count button will count the number of records that
begin with the text you enter.

 

 Enter methyl isocyanate and click Find.
 

 The first occurrence of the Chemical Name beginning with methyl isocyanate is
displayed.  By knowing the name of a chemical, the Find menu item is an effective
method in obtaining the detail record for the chemical.  However, there are limitations.
The Find menu item works best with a complete chemical name and will not work in
instances in which you are given a partial chemical name.  For example, a local
firefighter finds a torn label with the phrase “methyl iso” and an Extremely Hazardous
Substance (EHS) classification.
 



136

 After accessing the Find menu item, enter “methyl iso” in the search
entry and click Find.

 

 CAMEO displays the first record that matches, methyl iso-butyl ketone. By clicking on
page 2 of the detailed chemical information window, you can determine that the chemical
is not listed as an EHS.  Therefore, this is not the correct chemical.  To demonstrate the
limitations of the Find menu item:
 

 After accessing the Find menu item, enter “methyl iso” in the search entry and
click Count.

 

 Note that the Count function returns 28 chemicals beginning with “methyl iso.”  This
search method was limited because the Find menu item does not allow a search using
several conditions.
 

2) The Find All menu item
 The Find All menu item can be used for simple searches and is useful if you need to
capture a set of chemicals that begin with the same characters.  Upon using this search
method, CAMEO displays all the records that meet your criteria.  In continuation of our
comparison, we are now searching for all chemicals that would fit the parameters
discovered by the firefighter.
 

 After entering the Chemical Information Module, go to the View Menu and click
on Find All.  Use the Tab Key until you highlight Enter Value to Search For:.
Enter “methyl iso” and then click on Set.

 

 CAMEO captures 28 chemicals in the filter but includes synonyms.  This observation can
be determined by scrolling to the Preferred Chemical Name column.  Chemical names
that have an F (False) under this column are regarded as synonyms in CAMEO.  To view
only the true chemical names, designated by T, we need to exclude the synonyms.
 

 Again select the Find All menu item.  Once the Clear Filter? alert is displayed,
click No to match the current filter and the new filter criteria.  Select Preferred
Chemical Name? in the data field, enter “T” in the search entry, and then click
on Set.

 

 CAMEO captures seven chemicals in the subset of this filter.  Because we are still
searching for the chemical that meets the specific criteria, the subset can be visually
condensed.  By using your arrow keys and scrolling to the left, you can determine that
both methyl isocyanate and methyl isothiocyanate are listed as EHS chemicals.  Again,
this search method was limited because the Find All menu item does not allow a search
using several conditions and only matches records beginning with “methyl iso.”
 

 To exit the Find All filter, click on Clear Find All in the View Menu.
 

3) The Quick Chemical menu item
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 Although you must be in the Chemical Information module, the Quick Chemical menu
item is a helpful tool for searching many parameters in one pass.  The Quick Chemical
query also allows the stringing of various conditions with AND and OR connectors to
modify the search.  Its dialog box includes the most frequently searched fields in the
Chemical Database.  To demonstrate this feature, let’s use the following parameters; the
chemical name begins with “methyl iso,” an EHS classification of Y, and an NFPA
Health Hazard (H) of 4.
 

 Click the Quick Chemicals menu item to display the Quick Chemical Query dialog
box.  Enter the text in the appropriate fields and click Run.

 

 CAMEO displays the only record that match these specific parameters, methyl
isocyanate.
 

 To exit the Quick Chemicals filter, click on Clear Quick Chemicals in the View
Menu.

 

 The Quick Chemical query is formatted to search only for records that begin with the text
you enter.  Therefore, the Quick Chemical query can not be used to search for records
containing a specific phrase.
 

4) The Query menu item
The Query menu item is CAMEO’s most complex search function.  The query menu item
can provide a specialized view of information in a database by offering the most
flexibility and control in searches.  Like the Quick Chemical query, various conditions
can be strung together with AND and OR connectors to modify the search.  How you
connect the various conditions makes a significant difference in the results.

Because nomenclature is often different among individuals, the user can obtain trade
names for a particular chemical.  Let’s use the following parameters to demonstrate the
Query menu item; the chemical name begins with “methyl iso” and the CAS Number
begins with 624.

Click the Query menu item to display the Query List Manager and press Add.
Once you have given your query a unique name, you will need to complete a
series of steps.  In Step 1: pick a field by locating Chemical Name and pressing
Enter.  In Step 2: select “Begins with or matches” as the pick operator.  In Step 3,
enter the comparison value as “methyl iso” and click OK.  Again click OK to exit
and save changes.

To simplify your filter, you may want to view only the true chemical names by excluding
all the synonyms.  Thereby, you will have to add a condition to obtain only the true
chemicals that begin with “methyl iso.”

Click on Add in the Filter Building dialog box.  You will be asked to select a
connector.  Click on And to specify that both this condition and the prior
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condition must be true.  In Step 1: pick a field by selecting “Is Chemical
Preferred?” and pressing Enter.  In Step 2: select “Is true” as the pick operator.
Click OK to exit and save changes.

The query currently specifies that the previous conditions must be true.  Let’s go ahead
and include the CAS Number. When searching for a CAS Number, the Find or Find All
menu items can not be used because there is no corresponding field in which to find the
data.  The Quick Chemical menu item will not accept any CAS Number with less than
five digits.

Click on Add in the Filter Building dialog box.  You will again be asked to select
a connector. Click on And to specify that this condition and the two prior
conditions must be true.  In Step 1: pick a field by locating CAS # and pressing
Enter.  In Step 2: select “Begins with or matches” as the pick operator. In Step 3,
enter the comparison value as “624” and click OK.  Click OK twice to exit, save
changes, and return to the Query List Manager.

To complete the query:

Click Select on the Query List Manager.  Query Maker will present the Select
Fields to Show in Query dialog box.  For this example, select Chemical Name and
CAS # and click OK to proceed to the Query Overview dialog box.  We will
accept the filter and press Run Query.

The advanced search query displays the chemical methyl isocyanate.  You can now
access the detailed chemical information for this chemical.

To exit the Query Filter, click on Clear Query in the View Menu.

To test your comprehension of the various search functions, additional problems can be
found in Problem Set 2 of your workbook.

Break (2:45-3:00 pm)
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There are four query methods to extract records from CAMEO.  Reviewing the
different queries will allow us to compare and contrast the various search
functions.
The Find menu item is a quick search that you can perform in any module, such
as Facility, Chemical Information, or Route.  You can specify a number or text to
search for in several predefined fields.  A field could be for example, the
Chemical or Facility Name.  The Find search will match your criteria with the first
record found in the database.

Reviewing the Different
Queries

● Find
» Search any module

» Search one field at a time (pick one of
several choices)

– Matches records beginning with the text you
enter

» First record found

» No “clear” necessary - each search clears
the last one
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The Find All menu item is a simple search that is useful when capturing several
records meeting your criteria.  For example, in the Facilities module, Find All
could be used to view all the facilities in the location city, Haymarket, VA.
However, this search tool, as well as the Find menu item, can only search the
database using one field at a time and matches records beginning with the text
you enter.

Reviewing the Different
Queries

● Find All
» Search any module

» Search one field at a time (pick one of
several choices)

– Matches records beginning with the text you
enter

» Capture all records meeting criteria

» Need to clear Find All
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The Quick Chemical menu item is a tool only used in the Chemical Information
module.  Quick Chemical has the advantage of searching several fields at once.
For example, you could search for all of the chemicals that begin with chlorine
and are designated as extremely hazardous substances.  Another important
feature is the use of logic when combining several conditions.  Your search can
be modified by using “and” and “or” connectors.

Reviewing the Different
Queries

● Quick Chemical
» Search only Chemical Information module

» Search several fields at once

» And/or capability

» Only matches characters beginning with
the specified letters
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The Query menu item is CAMEO’s most complex Query function.  This search
method gives the most flexibility, in terms of field choices, and control in a
search.  As in the Quick Chemical menu item, a search can be modified by using
“and” and “or” connectors to combine several conditions.  Using the Query menu
item, you can also search for records that may contain or end with a specific
phrase.  Finally, Query stores the search and the outputs.

Reviewing the Different
Queries

● Query
» Search any module

» Search several fields at once

» And/or capability

» Most flexible search (many search fields)

» Searches partially defined text/numbers

» Stores search/outputs
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Script Notes for Sessions VII and VIII
 

 

 Day Two
 

 VII.  Sharing Menu (3:00-3:45 pm)
 
 Learning Objectives:  To ensure that the class understands how CAMEO can be used to
interact with other software applications in the CAMEO suite.  The purpose of this
demonstration is not to show the class how to perform a wide variety of steps in
CAMEO, but rather to ensure that they understand the capabilities of the CAMEO
sharing menu and its interaction with MARPLOT and ALOHA and also interactions with
LandView.
 

 MARPLOT
•  Discuss MARPLOT and its uses
•  Link to CAMEO to show scenario

− Link Green Valley Water Facility using MARPLOT
•  Show how to access the Screenings & Scenarios module and display a threat zone on

a map using MARPLOT
 

 ALOHA
•  Discuss ALOHA and its uses
•  Pre-load ALOHA with the current chemical record in CAMEO, use the Green Valley

scenario analyzed in CAMEO
•  Display footprint
 

 LandView
•  Discuss LandView and its uses
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Detailed Script for Sessions VII and VIII

Day Two

VII.  Sharing Menu (3:00-3:45 pm)

During this session, instructor covers the Sharing Menu and CAMEO's interaction with
MARPLOT and ALOHA, and also with LandView.

Click on the Sharing menu.

1) MARPLOT
Now that you have practiced some hands-on exercises, let's learn how information from
the CAMEO component can even be more useful.  It starts with the concept of sharing.
The components of CAMEO work together and communicate via the sharing menu.

Click on the Sharing menu which is the rightmost menu.  Note that ALOHA,
MARPLOT, and Site Plan Viewer can also be accessed.  Let's start with
MARPLOT.

MARPLOT is a general-purpose mapping application program that allows the user to
create, view, and modify maps.  More important to CAMEO users, it allows the user to
link information entered into CAMEO to a map.

Click on the MARPLOT submenu and click on Go to MARPLOT, and then click
OK at the title page.

MARPLOT can plot two types of information on maps:  one is CAMEO files, which
include scenarios, facilities, schools, and all the other data that we have previously
discussed; the second is Census data.   Census information has been extracted from the
Bureau of the Census' TIGER/Line files.  Information available in MARPLOT includes
jurisdictional boundaries (such as states, counties, and cities and towns), rivers, railroads,
detailed street maps, and demographic information, among other categories.

1a) Link to CAMEO to show scenario
In order to learn how MARPLOT interacts with CAMEO, we will access the Screenings
& Scenarios module in CAMEO to estimate the radius of a threat zone and plot the zone
on a map using MARPLOT.  First, we need to start in MARPLOT and link the object for
which we are interested in obtaining threat zone calculations.  Linking an object means
that a map object is connected to detail record of a CAMEO module.
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Instructor demonstrates only:

For this example, we are going to use the Green Valley Water Facility.  To find the
location of the facility, search for it using the Search function under the List menu.

Click Search under the List menu.

To search for the Green Valley Water Facility, we need to type in its name and search for
it in the CAMEO Facilities layer.

In the Search Criteria dialog box, select "with names that start with..." and type
in "Green Valley" under the "Search for objects:" category.  Under the "Layer(s)
to search:," category, select "Individual Layer..." and CAMEO Facilities.

When we're done inputting the information in the Search Criteria dialog box, we

click Search.

When the Search Collection comes up, Green Valley Water Facility is the only entry.
We want to see a close-up view, so we

click Show on Map & Zoom in the Search Collection dialog box.

MARPLOT now displays the zoomed-in view of Green Valley Water Facility with the
facility highlighted by red boxes.

We need to link Green Water Valley Facility to MARPLOT by using the Link function
under both CAMEO and MARPLOT.

Under the Sharing menu, click CAMEO and then click Link Object.  Once
CAMEO comes up, click Facilities under the File menu.

Since we are interested in the Green Valley Water Facility,

highlight Green Valley Water Facility record.  Click Link under the Link to
MARPLOT menu.

Once the link is complete, MARPLOT comes forward.  You can test the link by clicking
Get Info under the Sharing CAMEO menu.  If the link is done correctly, CAMEO will
display the Facilities detail window for Green Valley Water Facility.

To test the link, click MARPLOT's Sharing CAMEO menu and click Get Info.

1b) Show how to access the Screenings & Scenarios module and display a threat
zone on a map using MARPLOT.

I am now going to show you how to access the Screenings & Scenarios module.
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Click on Screenings & Scenarios under the Show Links submenu of the Record
menu. Double-click on the first chlorine record in the dialog box.

CAMEO displays the browse window of all Screenings & Scenarios detail records for the
Green Valley Water Facility.  Click on the first chlorine record to view its detail window.
This record shows results of "credible worst case" screening calculations for chlorine at
the Green Valley Water Facility, made according to procedures described in the
Technical Guidance.

We can move to the next record in the module to see the release scenario for chlorine.

Click on the red next arrow to see the next record.

We can also view information on chlorine by clicking the RIDS button, which provides
various response information data.

To view information on chlorine for this facility, click on RIDS.

When we are finished viewing, click Cancel.

To plot this threat zone in MARPLOT, click on Show on Map under the MARPLOT
submenu of the Sharing menu.

Click Show on Map under the MARPLOT submenu of the Sharing menu.

MARPLOT comes forward and the threat zone is automatically plotted, centered on the
Green Valley Water Facility symbol.  Select the zoom-out tool on the left-hand side of
our screen, and click once or twice at the center of the facility.

Select the zoom-out tool which is a plus in the magnifying glass symbol, and click
at the center of the facility.

Once we zoom out far enough, we will be able to see the plume of chlorine gas that was
developed based on the current meteorological conditions and the radius of potential
effect.  When we are finished using the zoom-out tool, we deactivate the zoom-out tool
by moving the mouse and clicking on the arrow tool with the cursor.
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We can still click on map objects with the Arrow tool and identify them when we have a
plume plotted on your map.  We use the Arrow tool and click on the road located on the
map in the area of the plume.

Click with the Arrow tool on the road located within the plume on the map.

We are now able to identify Logmill Rd.  This feature is useful for identifying objects
within the range of a plume.  Once an object is identified within the threat zone, contact
information can be determined and recorded for use in the event of a release.

Click on the Go to CAMEO under the CAMEO submenu of the Sharing menu in
MARPLOT.

2) ALOHA

Now that we understand a bit more on how MARPLOT functions, let's see how ALOHA
can work hand-in-hand with CAMEO information and with MARPLOT to map the
ALOHA-calculated plume areas.  ALOHA, the third CAMEO component, is a more
complex modeling tool for estimating the movement and dispersion of hazardous
chemical releases.  It determines the pollution concentrations downwind from the source
of the release, taking into consideration the specific toxicological and physical
characteristics of the released chemical, as well as the specific circumstances of the
release scenario.  ALOHA solves the release problem rapidly and provides results in a
graphic, easy-to-use format including plots of plume areas and concentrations.

Using the Sharing menu, you can automatically load the chemical you were viewing in
CAMEO into ALOHA.  This means you can be viewing chlorine in RIDS, start ALOHA
using the sharing menu and ALOHA will know that chlorine is the chemical you want to
model.
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Remember the Green Valley scenario analyzed in CAMEO.  We can refine this analysis
using ALOHA to specify more release and site-specific parameters.  ALOHA can be
accessed easily through CAMEO by using the Sharing Menu.  ALOHA can be used to
model releases of any of the 700 chemicals included in its database or additional
chemicals that the user chooses to add.

Under the Screenings & Scenarios option of CAMEO's File menu, click on the
first chlorine entry and view the Detail window version of this entry.  Click Select
this Chemical in ALOHA under the ALOHA submenu of the Sharing menu.

ALOHA automatically inputs the information for chlorine into the Text Summary pop-
box of ALOHA.  Atmospheric conditions can greatly influence the dispersion of a
chemical.

Under the SetUp menu, click on Atmospheric and then click User Input to display
Atmospheric Option pop-up box.  Click Cancel after you finished viewing.

ALOHA permits you, under the Atmospheric option of the Setup menu, to specify an
assortment of parameters including, wind speed, wind direction, ground roughness, cloud
cover, atmospheric stability, air temperature, and humidity.  You can even feed real-time
weather data directly into ALOHA through a meteorological station.

In ALOHA, you also can define the amount and type of chemical release including
whether the spill scenario resembles a puddle release, a tank release, a pipe release, or
simply a direct gas release to the air.  For example, to expand on the Green Valley
scenario, you could specify the size and orientation of the chlorine tank, and on other
menu screens, specify more information, such as the tank pressure and the area of the
hole.  ALOHA will automatically determine the release rate from the tank, you or the
model can choose an exposure concentration of interest, and ALOHA will then run the
appropriate dispersion model.

The result is a dispersion footprint that provides a view of the spread of the gas cloud.

Click on Footprint under the Display menu.

The shaded areas are those where the surface is at or above the level of concern (LOC)
and the dashed lines on either side of the plume indicate possible plume movement based
on uncertainty in the wind direction.  Note that ALOHA provides a plume with a
directional component, in contrast to CAMEO’s Screenings and Scenarios module, which
creates a circular vulnerable zone.
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Double-click on the Footprint Window to exit out.  Click Go to CAMEO under the
CAMEO submenu of the Sharing menu.

3) LandView
Instructor lectures on the uses of LandView by using a series of PowerPoint slides.
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LandView III, a software application outside of the overall CAMEO system, can
also provide useful interactions with CAMEO.  LandView III is an innovative
“community right-to-know” software tool in the format of an electronic atlas.  The
information that LandView III displays in maps and tables combines EPA
databases with geographic features and statistics on demographics and
economics from the 1990 Census.  The LandView III software package combines
the LandView III database management system with the MARPLOT mapping
application, which allows you to display and manipulate the information on a
map.

LandView III
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LandView III is a database management system that contains:
∙ EPA-regulated site locations and information;
∙ TIGER/Line map data;
∙ Demographic and economic data from the Census Bureau; and
∙ Miscellaneous public structures and facilities.

This information is presented in a geographic context that includes:
∙ Jurisdictional entities (states, counties, cities & towns, and congressional
districts) and other geographic entities (such as ZIP code reference points);
∙ Detailed network of major and minor roads, rivers, and railroads;
∙ Census block groups and tracts; and
∙ Selected landmarks.

Site, demographic, and geographic information are integrated and accessible
through software that provides:
∙ Essential desktop mapping capabilities for displaying, searching, and identifying
map objects;
∙ Thematic mapping   choosing display attributes based on database information
or relation to other map objects; and
∙ Printed maps and reports.

LandView Information

● LandView is a database management
system

● Information is presented in a geographic
context

● Site, demographic, and geographic
information are integrated and
accessible through various software
applications
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LandView III provides a wealth of information that corresponds to applications in
CAMEO.  Using LandView information with the vulnerable zone created by the
Screenings and Scenarios module is a prime example of this application.  Data
for the vulnerable zone is inputted in CAMEO, and then the vulnerable zone is
plotted visually in MARPLOT.  If you have LandView III software, you can access
LandView through its sharing capacities with MARPLOT.  You can find out
information on the population or economic situation by accessing LandView's
Census Data database.

The Census Data database provides an opportunity to input a thematic set or
search on the data points you are interested in.  This function in LandView
provides more detailed information about who is effected in the vulnerable zone
(e.g., minorities, low-income, young children).  This slide shows an example of
the minority population distribution in Prince William County.

LandView and CAMEO

● Use LandView information with the
vulnerable zone created in the
Screenings & Scenarios module of
CAMEO
» Find out information on population or

economic situation in the vulnerable zone
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 Script Notes for Session I
 

 

 Day Three
 

 I.  Refresher (8:30-9:00 am)
 
 The trainer will review key concepts taught during the previous day(s) and any issues
identified during Day One and/or Two.  The trainer will allow time to answer any
questions that the class may have before proceeding with Day Three agenda.
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Examples of CAMEO Modules to Support Hazards Analysis
To demonstrate carrying out a risk analysis using CAMEO, we will work through an
example based on a specific facility with a hazardous chemical on site.

1) Facilities

Click on Facilities in the File menu.

The Facilities module gives you a list of facilities with information about the facility and
the chemicals on site.  This information is filled in by planners for their communities.
We are going to look at the Green Valley Water Facility.

Go to Green Valley and click on View Detail.

Look at the Detail pages for the Green Valley facility.  These screens give you basic
information about the facility - its location, phone number, and other information.

For the hazards identification part of the hazards analysis, you need to know what
chemicals are present at the facility, their location, what quantities are present, and what
kind of storage containers are used. We can look at the links to this facility to see what
kind of information is available.

Click Record, then click Show Links.

As you can see, the links include Chemicals in Inventory/In Transit, Storage Locations,
Screenings and Scenarios, Toxic Release Inventory, Incidents, Contacts, and Routes.  We
are going to look at the links that are important for hazards analysis - first Chemicals in
Inventory/Transit, then Storage Locations, and finally Screenings and Scenarios.

2) Chemicals in Inventory/Transit

Click Chemicals in Inventory/In Transit.

The first Chemicals in Inventory/Transit screen lists the chemicals at the Green Valley
Water Facility.  You see that the facility has chlorine.

Click View Detail.

From the Detail screen, you can see that the maximum quantity of chlorine at the facility
is 2,000 pounds.  There is some information about the physical state and hazards of
chlorine.  You see that the facility has chlorine in four storage locations.

Click Show Links
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Chemicals in Inventory/Transit is linked to both Chemical Information and Storage
Locations.  We will look at both these links for more information about chlorine and how
it is stored at this facility.  First, we will look at Chemical Information.

3) Chemical Information

Click Chemical Information

Click View Detail

You can get a variety of information here about chlorine and its hazards.  On the second
page, the EHS box is checked, which tells you that chlorine is an extremely hazardous
substance regulated under EPCRA section 302.  For more information on hazards and
response, you could pull up the RIDS for chlorine, but we won’t do that now.  Now we
will look at the storage locations for chlorine at the Green Valley facility.

Click Record and Show Links again.

4) Storage Locations

Click Storage Locations.

You can view a Detail screen for each of the four storage locations.

Click View Detail.

You can look at each of the storage locations and see that the chlorine is stored in above-
ground tanks at greater than ambient pressure and at ambient temperature in all four
locations.  This helps to let you know what kind of release to expect, for example, from a
puncture in the tank, given the storage conditions.

Now you have enough information for the hazards identification segment of the hazards
analysis.

Click Record, Show Links, and go back to Facilities

5) Screening and Scenarios - Initial Evaluation
For the vulnerability analysis, CAMEO’s Screening and Scenarios module provides
calculations based on the Green Book methodology discussed earlier.  As discussed
earlier, the hazards analysis should include an initial evaluation and a reevaluation of the
hazards.  The Screening and Scenarios module allows you to carry out  both the initial
evaluation (called screening) and the reevaluation (called scenario).  The Screening and
Scenarios module is also linked to Facilities .

Click Record and Show Links again.
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Click on Screening and Scenarios

You see that there are two entries for the Green Valley Water Facility in the Screening
and Scenarios module.  The first one is the initial evaluation or screening.

Click View Detail.

The initial evaluation, or screening, uses the worst-case assumptions specified in the
“Green Book” to estimate the area that could be affected by a release under worst-case
conditions.  For this facility, the maximum quantity of chlorine on site (2,000 pounds) is
assumed to be released in 10 minutes.  Worst-case assumptions of low wind speed and
stable atmosphere are used in the analysis.  The vulnerable zone estimated using these
assumptions and the Green Book methodology is greater than 10 miles.

You can see the vulnerable zone estimated in the screening step by using the mapping
application, MARPLOT.  Don’t worry about all the details of using MARPLOT.
Instead, enjoy MARPLOT’s capabilities in helping with the hazards analysis.

Click the Sharing menu, click MARPLOT, and then click Show on Map.

We find that the worst-case vulnerable zone radius of greater than 10 miles is too large
for MARPLOT to handle.

6)Screening and Scenarios - Reevaluation
Now we want to reevaluate the chlorine release, using assumptions that reflect more
likely release conditions.

Go back to Screenings and Scenarios and select the second entry (Scenario) for
the Green Valley Water Facility.

Here, the chlorine release has been reevaluated using different assumptions.  In this case,
the total quantity of chlorine has been assumed to be released, as before, but the duration
of the release is now assumed to be 30 minutes, instead of 10 minutes.  The duration of
the release could be revised if a longer duration is considered more likely because of past
experience, information on the design of the storage container, or other factors.  The wind
speed in this case is assumed to be 12 miles per hour, significantly higher than for the
worst case, and the atmospheric stability class is D, or neutral stability.  Revised wind
speeds and atmospheric stability could be based on common conditions at the site.

The reevaluated vulnerable zone radius is 0.8 miles, more than an order of magnitude
smaller than in the worst case.  Let’s look at the map again to see what the area the
revised vulnerable zone covers.

Click the Sharing menu, click MARPLOT, and then click Show on Map.

Click on flagged buildings.
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The vulnerable zone includes an elementary school and a religious institution.
Remember from the session on census data on the first day of training that you could also
determine the total population in the census blocks that contain the vulnerable zone.

Now go back to the Screening and Scenarios screen.

Click Sharing menu, then CAMEO.

7) Screening and Scenarios - Risk Analysis
The final step of a hazards analysis is the risk analysis.  CAMEO does not do this for you.
Screening and Scenarios includes a section for entry of your qualitative assessments of
likelihood of occurrence, severity of consequences, and overall risk.  The screen says
“Risk of Release,” which means likelihood of occurrence, and “Consequences of
Release,” which means of severity of consequences.  You will have to look at the
assumptions you made about the release, the characteristics of the facility, history of
releases at the facility, the results of the vulnerability analysis, and any other relevant
information to judge whether your assessment of each category should be high, medium,
or low.

Let’s look at risk for the reevaluation scenario.

We probably could say that the likelihood of a release of the entire contents of a storage
tank of chlorine is low, but we might want to look for additional information.

Click on pencil in toolbar to get into edit mode and choose low for the risk of
release field.

Based on the vulnerability analysis and what MARPLOT showed us, we can say that the
severity of the consequences of the release are high.

Choose high for consequences of release.

For a preliminary estimate of risks, we might say the likelihood of release is low, the
severity of consequences is high, and the overall risk is medium.

Choose medium for overall risk of release.

For more information on the likelihood of release, we could go back now and see if there
is information about previous incidents at the Green Valley Water Facility.

8) Incidents

Go back to Facilities, click Records and Show Links again.

Click on Incidents.



158

There was a release of chlorine in the past at the Green Valley Water Facility, resulting
from a valve failure. The record of the incident does not tell us how much chlorine was
released, how long the release continued, or other details.  If you were actually doing a
risk assessment, you might want to ask the facility for more information.

Adding Information to CAMEO for Hazards Analysis
If you were a planner carrying out hazards analysis for planning in your community, you
would want to include a list of facilities in your community and the chemicals found at
those facilities.  You would enter information about each facility in the Facilities
database, add information about chemicals stored there to Chemicals in
Inventory/Transit, and develop scenarios in the Screening and Scenarios module.

Lunch (12:00-1:00 pm)
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 Script Notes for Session II
 

 

 Day Three
 

 II.  Hazards Analysis (9:00-10:00 am)
 

 Learning Objectives:  To explain legislative background.  To explain the purpose and
benefits of hazards analysis and identify the steps in conducting a hazards analysis.
Students will understand the difference between the initial evaluation phase and the
reevaluation phase of the hazards analysis.
 

 Questions responders and planners encounter
•  Which hazards should be addressed first?
•  Are existing emergency plans adequate?
•  Are response capabilities adequate?
 

 Purpose of hazards analysis
•  Understand what hazards exist
•  Understand what risk these hazards pose to the community
•  Help planners develop and revise emergency response plans
 

 Legislative background
•  EPCRA
•  Clean Air Act, Section 112(r)
 

 The hazards analysis process
•  Hazards identification
•  Vulnerability analysis
•  Risk analysis
 

 The initial evaluation
•  Worst-case assumptions
•  Establishing priorities
 

 The reevaluation
•  Hazards identification based on revised assumptions
•  Vulnerability analysis based on revised assumptions
•  Risk analysis
 

 

 Break (10:00-10:15 am)
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In this session, I will introduce you to hazards analysis, which is a powerful
analytical tool for emergency planners and responders.

Later, in the session that follows this one, you will see how CAMEO and its
companion applications support a hazards analysis.

HAZARDS ANALYSIS
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Planners and responders have to make a number of decisions.

They must identify the hazards in their communities and decide which hazards
their plans should address first.

They must decide whether their emergency plans are adequate to deal with
existing hazards.

They must decide whether they have adequate capabilities to respond to
emergencies that might arise.

An analytical tool called hazards analysis can help planners and responders to
develop their plans and make the necessary decisions.

PLANNERS’ AND
RESPONDERS’ QUESTIONS

● Which hazards should be addressed
first?

● Are emergency plans adequate?

● Are response capabilities adequate?
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Hazards analysis considers all potential acute health hazards within a
community.  Analysis of such hazards is a necessary step in comprehensive
emergency planning for a community.  Comprehensive planning depends on a
clear understanding of what hazards exist and what risk they pose to the
members of the community. The hazards analysis may be complex or relatively
easy, depending on the community

The hazards analysis can provide essential information for developing,
assessing, and revising emergency plans, and setting priorities for planning.
Hazards identified as posing the greatest risk can be addressed first in
emergency plans, and energies can be focused on the highest risks. The
hazards analysis should help planners identify additional response capabilities
needed.  It should serve as the basis for development or revision of emergency
response plans required under specific regulations.

PURPOSE OF HAZARDS
ANALYSIS

● Understand what hazards exist

● Understand what risk these hazards
pose to the community

● Help planners develop emergency
response plans

● Help planners revise emergency
response plans
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EPCRA or Title III of the Superfund Amendments and Reauthorization Act
(SARA) establishes state and local committees to address chemical
emergencies.  Under EPCRA:
•    Local Emergency Planning Committees, or LEPCs, must  prepare

comprehensive emergency plans
    --  Plans must identify facilities with extremely hazardous substances, or EHSs
    --  Plans must identify other facilities subject to risk
    --  Plans must include the area or population likely to be affected by a release
of an EHS
    --  A hazards analysis is necessary for development of the plan
•    Facilities are responsible for providing a variety of information useful for

hazards analysis
• EPA developed a guidance document called the Technical Guidance for

Hazards Analysis (the “Green Book”).  This guidance provides a simple
hazards analysis process to aid LEPCs in meeting the requirements for
development of emergency plans under EPCRA.  The  Green Book hazards
analysis process is incorporated into CAMEO.

• Another statute, Section 112(r) of the Clean Air Act (CAA), is intended to
prevent and mitigate accidental chemical releases to air.  Under section
112(r):

•   Facilities with regulated substances above their thresholds must develop risk
management plans, or RMPs, to reduce the risk of chemical accidents.

•   RMPs must include a hazard assessment, a prevention program, and an
emergency response program.  The hazard assessment must include offsite

LEGISLATIVE BACKGROUND

● The Emergency Planning and Community
Right-to-Know Act (EPCRA):

-- Establishes state and local planning structure

 -- Requires LEPCs to conduct hazards analyses
for EHSs

-- Includes various reporting requirements for
hazardous substances

● Section 112(r) of the Clean Air Act (CAA):

 -- Requires facilities with regulated substances
to develop risk management plans (RMPs)



164

consequence analyses for regulated substances, which include specific toxic
and flammable substances.

• The Green Book hazards analysis process used in support of EPCRA is
different from the hazard assessment required by the RMP rule.
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Hazards analysis is an important part of the planning process required under
EPCRA.  It provides information about the hazards in a community that can be
used in developing the emergency plan.  A hazards analysis is conducted close
to the beginning of the planning process.

OVERVIEW OF PLANNING
PROCESS

Conduct Hazards AnalysisConduct Hazards Analysis

StartStartStart Local Emergency Planning
Committee Formed

Local Emergency PlanningLocal Emergency Planning
Committee FormedCommittee Formed

Begin to PlanBegin to PlanBegin to Plan

Assess Response 
Capabilities

Assess Response Assess Response 
CapabilitiesCapabilities

Review and Coordinate
with Existing Plans

Review and CoordinateReview and Coordinate
with Existing Planswith Existing Plans

Develop PlanDevelop PlanDevelop Plan
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The hazards analysis process presented in the Green Book is a three-step
process:  hazards identification, vulnerability analysis, and risk analysis.

The first step in the hazards analysis is hazards identification, which includes
gathering information on hazardous chemicals in the community.  The hazards
identification provides information that helps planners and the community
understand what hazards are present.

The second step in the hazards analysis is vulnerability analysis.  The Green
Book provides a methodology for estimating the consequences of releases of
EHSs to estimate the extent of the “vulnerable zone.”  The vulnerability analysis
provides information on the potential consequences that could result from the
hazards in the community.

The final step of the hazards analysis is the estimation of risk, considering the
likelihood of releases and the severity of consequences of such releases.  The
Green Book provides procedures for developing qualitative estimates of risk.
The risk analysis combines and assesses the information developed by the
hazards identification and vulnerability analysis to provide an understanding of
the risk the hazards pose to the community.

HAZARDS ANALYSIS
PROCESS

Hazards IdentificationHazards Identification

Chemical Identity

Location

Quantity

Nature of the 
Hazard

Vulnerability AnalysisVulnerability Analysis

Vulnerable Zone

Human Populations

Critical Facilities

Environment

Risk AnalysisRisk Analysis

Likelihood of a
Release Occurring

Severity of the
Consequences
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Hazards identification requires planners to determine where and how hazardous
materials are stored, handled, and processed in their community.  It also requires
identifications of routes by which hazardous materials are transported into or
through the community.

Information needed for the hazards identification is available from several
sources.
•   Under EPCRA, facilities with EHSs must identify themselves and provide

information on request.  Information could be requested on chemical
identities, location of the facilities, type and design of the chemical container
or vessel, the quantity that could be involved in an airborne release, and the
nature of the hazard of the chemical.

• The nature of the hazard could include toxicity, flammability, and explosive
properties.  These hazards could lead to toxic clouds, fires, and explosions
following a release.

• Information on the nature of the hazards of EHSs can be found in  EPA
Chemical Profiles.  These Profiles provide information on physical/chemical
properties and hazards of EHSs (including fire and explosion hazards)

HAZARDS
IDENTIFICATION

● Chemical identities

● Location

● Type of containers

● Quantities

● Nature of the hazard

-- Toxic cloud

-- Fire

-- Explosion
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A toxic cloud can result from the release of gas, vapor, or finely divided solid to
air.  The substance can be released directly from a container into the air or can
evaporate from a pool on the ground.  The hazard is primarily from inhalation as
the cloud travels downwind.  CAMEO addresses such toxic cloud releases.

TOXIC CLOUD
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Other potential consequences of chemical releases include explosions and fires.

Explosions, which can expose people to dangerous overpressure levels, may
result from hazardous reactions, ignition of vapor clouds, or explosive
decomposition of an inherently unstable substance.

Fires, which can expose people to dangerous levels of radiant heat, may include
fireballs resulting from boiling liquid, expanding vapor explosions (BLEVEs); pool
fires of flammable liquids, jet fires resulting from the leak of a flammable
pressurized gas, and vapor cloud fires.

CAMEO does not model consequences of fires and explosions.

FIRE/EXPLOSION
HAZARDS

OverpressureOverpressure Radiant HeatRadiant Heat

Explosion BLEVE

Pool Fire

Jet Fire

Vapor Cloud Fire
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Vulnerability analysis identifies areas in the community that may be affected or
exposed; individuals who may be subject to injury or death; and facilities,
property, or environment that may be damaged if a hazardous materials release
occurs.

The analysis estimates a vulnerable zone.  To determine the size of the zone,
planners need to estimate the extent of the area potentially affected by a spill or
release of a known quantity of a specific chemical under defined conditions.

The population within vulnerable zone includes the number of people,
population density, and the types of individuals, such as

--  facility employees
--  neighborhood residents
--  people in hospitals, schools, nursing homes, day care centers

Property, both public and private, within the vulnerable zone that should be
considered includes any property that might be damaged, such as:

--  critical facilities, homes, schools, hospitals, businesses, offices
--  essential support systems -- water, food, power, communication, medical
--  transportation facilities and corridors

The vulnerability analysis also needs to consider the impact of a release on
sensitive natural areas and endangered species to determine the affected
environment within vulnerable zone.

VULNERABILITY ANALYSIS

● Extent of vulnerable zone

● Population within vulnerable zone

● Property within vulnerable zone

● Affected environment within vulnerable
zone
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The vulnerable zone around a facility is the maximum distance at which the
concentration of a released substance would reach or exceed a certain defined
level of concern.

VULNERABLE ZONE

WindWind
DirectionDirection

FacilityFacility

SourceSource

Vapor CloudVapor Cloud

Release SiteRelease Site

Outer Edge ofOuter Edge of
VulnerableVulnerable

ZoneZone
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A risk analysis integrates the assessment of the likelihood (probability) of an
accidental release of a hazardous material and the severity of the consequences
that might occur, based on the estimated vulnerable zone.  The risk analysis is a
judgment of probability and severity of consequences, based on the history of
previous incidents, local experience, and the best available technological
information.

The Green Book method of risk analysis is a qualitative approach that requires:
•   Information from the hazards identification.
•   Information from the vulnerability analysis.
•   Information on facility and community plans and safeguards that might

mitigate the consequences of a release.
•   Information on existing local response capabilities.
•   Information on likelihood from historical records of past incidents.
•   Based on this information, likelihood and severity of an incident are ranked

qualitatively as high, medium, or low.  Risk is estimated as a combination of
likelihood and severity.

•   Note that in some cases, the potential severity of an incident might be very
high, but the likelihood of occurrence might be so low that the overall potential
risk to the community would be relatively low.  In fact, catastrophic accidents
involving hazardous chemicals are rare events.

•   Quantitative methods of risk analysis also are available.  These methods are
most commonly used to assess a single system and generally require
extensive data on the likelihood of failure of the components of the system.

RISK ANALYSIS

Assessment of:

● Likelihood (or probability) of an
accidental release

● Severity of consequences

● Ranking of combined likelihood and
severity

--  Qualitative or quantitative
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Such analyses may be carried out by industry in making decisions (e.g.,
decisions about process changes).

•   Relative, qualitative methods of assessing risk may be more useful than
quantitative methods when the data available are very uncertain and
resources are limited.
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The Green Book method involves carrying out an initial hazards analysis for
screening purposes.  This analysis uses credible worst-case assumptions to set
initial priorities for planning.

The initial screening is followed by a reevaluation.  For the reevaluation, a new
hazards analysis is carried out for facilities identified as high priority in the initial
screening.  The new hazards analysis is based on more likely assumptions,
including typical conditions in the community and facility, and additional
information.

CONDUCTING HAZARDS ANALYSIS:
INITIAL EVALUATION AND

REEVALUATION

Initial Screening

--  Use credible worst-case assumptions

--  Identify high priority facilities

● Reevaluation

--  Use more likely assumptions

--  Revise priorities
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For the initial screening step, the hazards analysis is carried out based on readily
available information and credible worst-case assumptions.

The Green Book provides a set of worst-case assumptions for evaluating
consequences of releases of EHSs, including assumptions regarding quantity
released, release rate, and atmospheric conditions.

Using these assumptions, the hazard identification and vulnerability analyses are
carried out.  The results of these analyses, along with other information, are used
to carry out an initial risk analysis.  For this initial risk analysis, a rough estimate
of risks is made.

Based on the initial risk analysis, high priority facilities are identified.  High priority
facilities may be those with the largest vulnerable zones, vulnerable zones
affecting the largest populations, or vulnerable zones affecting particular
populations (e.g., children in schools or on playgrounds)..

INITIAL EVALUATION

● Worst-case assumptions

--  Total quantity released

--  Low wind speed, stable atmosphere

● Establishing priorities

--  Identify high priority facilities
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The hazards analysis carried out in the reevaluation step should focus on
facilities identified as high priority.  The reevaluation should give a more realistic
picture of the hazards posed by these facilities.

For the reevaluation, the hazards identification segment of the hazards analysis
may be revised based on site-specific data provided by facilities with hazardous
substances and other relevant information.

The quantity likely to be released can be reassessed for a more realistic
estimate:
•   The worst-case quantity may be very unlikely to be released because of

safeguards, mitigation measures, or the properties of the substance; a
smaller quantity released may be more realistic.

•   The facility may provide a basis for a more likely release quantity, or other
information can be used for a new estimate.

•  A more likely rate of release can be estimated:
•   Worst-case assumptions may not be realistic, considering conditions of

storage or use and other factors.
•   The evaporation rate of liquid from a pool can be estimated using more likely

weather conditions.
• Wind speed, stability, and weather conditions assumed for the worst case

may be unlikely to occur at a particular location:
•   Actual wind speed and other weather data can be evaluated to estimate

typical or common conditions .

REEVALUATION

Hazards identification

● Reevaluate quantity likely to be
released

● Reevaluate likely rate of release

● Consider typical weather and wind
conditions
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Using more likely assumptions developed in the reevaluation of the hazards
identification portion of the hazards analysis, the vulnerability analysis should be
repeated to estimate more likely consequences of a release.
•   Start with facilities identified as highest priority (largest vulnerable zones).
•   Estimate new vulnerable zones, based on revised data.
•     -- Different modeling methods also could be used.
•   Estimate population potentially affected and identify critical facilities within

new vulnerable zone.
•    --  The new vulnerable zones are likely to be smaller; fewer people and

facilities may be affected.

REEVALUATION (continued)

Vulnerability Analysis

● Estimate vulnerable zone based on
more likely assumptions

● Identify population within new
vulnerable zone

● Identify critical facilities within new
vulnerable zone
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The risk analysis carried out in the reevaluation step may be more detailed than
that carried out for the initial screening, but will still provide a qualitative, relative
evaluation of risk, rather than a quantitative evaluation.

The Green Book provides instructions for developing a matrix as a means to
develop the risk estimates and summarize the results of the hazards analysis.
This matrix should present a summary of the results of the hazards identification
and the vulnerability analysis, including:
•   The chemicals present, their locations and quantities, and their hazardous

properties.
•   The size of the vulnerable zone and the population and essential services

within it.
• The matrix should then include a summary of the qualitative analysis of risks,

including:
•   Estimated likelihood of occurrence of chemical release (low, medium, high);
•   Estimated severity of consequences to people, property, and environment

(low, medium, high); and
•   An assessment of the risks based on a combination of likelihood and

severity of consequences.

REEVALUATION (continued)

Risk Analysis

● Tabulate hazards and vulnerability data

● Obtain additional information

● Judge probability of release, severity of
consequences

● Develop risk matrix

● Rank risks
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The Green Book suggests developing a matrix, as shown, to present the relative
risks of an incident.

For probability of occurrence:
•   Low means occurrence is unlikely during the lifetime of the facility,

assuming normal operations and maintenance.
•   Medium means occurrence is possible during the lifetime of the facility.
•   High means the event will occur at least once during the lifetime of the

facility.
• For severity of consequences to people:
•   Low means negligible chemical concentrations, resulting in injury only in

special circumstances.
•   Medium means chemical concentrations may be sufficient to cause deaths

or injuries in special circumstances unless prompt and effective action is
taken.

•   High means chemical concentrations may be sufficient to cause injury or
death, and large numbers of people may be affected.

• The combined qualitative estimates of the likelihood and severity of an
incident can aid in deciding which incidents to include in emergency planning.
In this matrix, the shaded area, or combinations of high and medium
likelihood with high and medium severity, identify situations of major concern.

• Another document, the Handbook of Chemical Hazard Analysis Procedures,
developed by EPA, FEMA, and DOT, suggests a somewhat more complex
matrix that includes more categories of likelihood of occurrence and severity

RISK ANALYSIS MATRIX

HighHigh

MediumMedium

LowLow

LowLow MediumMedium HighHigh

Severity of Consequences of an Accidental Release to PeopleSeverity of Consequences of an Accidental Release to People

ProbabilityProbability
or Likelihoodor Likelihood
of Releaseof Release
OccurringOccurring

These Combinations of Conclusions from Risk Analysis Identify Situations of Major ConcernThese Combinations of Conclusions from Risk Analysis Identify Situations of Major Concern
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of consequences and also assigns semi-quantitative definitions to these
categories.
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• 

 Script Notes for Sessions III and IV
 

 

 Day Three
 
 III.  Hazards Analysis and CAMEO (demonstration and hands-on) (10:15-11:15
am)
 
 Learning Objectives:  To review CAMEO modules that can provide inputs to hazards
analysis, understand how to use the Screening and Scenarios module to calculate the
vulnerable zone radius, and understand the use of MARPLOT to plot the vulnerable zone.
Students will follow along at their computers while the trainer demonstrates the subject
matter.
 
 Introduction to Use of CAMEO for Hazards Analysis
•  CAMEO modules useful for hazards identification
•  CAMEO modules useful for vulnerability analysis
•  CAMEO modules useful for risk analysis
 

 Demonstration of Hazards Analysis Using CAMEO
•  Show information available in CAMEO modules for hazards analysis for example

facility
•  Show initial evaluation (screening) and reevaluation (scenario) calculations for

example facility
•  Demonstrate use of MARPLOT for the example analysis
•  Demonstrate use of CAMEO for qualitative risk estimates for example analysis
 

 Discussion of Adding Information to CAMEO for Hazards Analysis
 

 IV.  Hands-on Exercises (11:15-12:00 pm)
 
 Learning objectives:  To “test” the class on their comprehension of sharing skills learned,
and to allow class members to work together to apply the lessons learned to actual,
simple problems likely to be encountered.
 
 Class members will work together in small groups (2-4 people) to answer the exercises,
which will be based upon existing case studies compiled by EPA/CEPPO.  One-half hour
will be allowed for the class to go through the exercises (with assistance from the
trainer(s), where necessary), with an additional 15 minutes allowed for discussion of the
answers and any additional questions the class may have.
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Day 3

IV.  Hands-on Exercises Hazards Analysis (11:15-12:00)

You are a planner, and you have learned that a facility, M & S Chemicals, has begun to
store acrylonitrile in a large, outdoor, above-ground tank at its Woods Lake Plant. The
material is stored under ambient temperature and pressure. The maximum quantity on site
is 50,000 pounds; the average quantity is 30,000 pounds. The tank is in a diked area that
is 50 feet square.  The facility is in a rural area with open terrain.  You want to include
this information in your hazards analysis for your community.  You need to: 1) add
acrylonitrile to the chemicals at the M & S facility and obtain chemical hazards
information; 2) carry out screening-level vulnerability analysis (for worst-case releases);
3) carry out screening-level risk analysis; 4) reevaluate vulnerability with a more likely
scenario; and 5) reevaluate risk and its impacts on community planning efforts.

Steps to follow:

1) Add acrylonitrile to the chemicals at the M & S facility and obtain chemical
hazards information.

a) From the File menu, choose Facilities.
b) Click on M & S Chemicals, then go to the Record menu, click on Show Links, and

choose Chemicals in Inventory/ in Transit.
c) From the Record menu, choose Add.
d) Type Acrylonitrile into the Chemical Name field and press Enter. When the name

acrylonitrile appears on a new screen, click on Select. Go to Record and click on
Save. (CAMEO links the record to the Chemical Information module and adds the
CAS number).

e) From the Record menu, click on Show Links, then Chemical Information to obtain
information on acrylonitrile (From Page 2, you can see that it is an EHS with a TPQ
of 10,000 pounds, its ambient state is liquid, it is considered a severe health hazard
and is also flammable, and it is fairly reactive).

f) From the Record menu, click on  Show Links, then Chemicals in Inventory/Transit to
go back to the new acrylonitrile record for M & S Chemicals. Click on Enter, then on
the pencil icon to edit the record. Add appropriate information on physical state (✓
for pure, ✓  for liquid) and hazards (✓  for Fire, Reactive, Acute).

g) Fill in the amount fields - type 50000 in Maximum, 30000 in Average. (Note that the
code descriptions are automatically filled in.)

h) Select Add below Storage Locations.  For Storage Type, select Above ground Tank.
For Storage Pressure, select Ambient pressure. For Storage Temperature, select
Ambient temperature. For Amount Stored, type in 50000; select “lbs” for units.

i) Click on Save.
j) From the Record menu, click on Save.
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2) Carry out a screening-level vulnerability analysis.  (Please note to be conservative,
you will not need to subtract the area of the tank.)

a) From the Record menu, select Show Links, then Screening and Scenarios.
b) From the Record menu, select Add.  This gives you a new screen for acrylonitrile.
c) Select the Screening radio button.
d) Type 50000 into the Maximum Quantity in Largest Reservoir: field.
e) Type 2500 into the Diked Area field (50 feet times 50 feet gives the diked area).
f) Select Physical State Liquid and choose Ambient.
g) You can not change the wind speed and atmospheric stability on thescreen.  These

parameters are based on a worst-case screening scenario identified in EPA’s
Green Book (i.e., wind speed of 1.5 m/s and an atmospheric stability of F).  Click
on Calculate.  CAMEO gives a worst-case screening distance of 0.5 miles.

3) Carry out a screening-level risk analysis.

a) Assess the risk of release (probably low for the release of the entire contents of a
large tank).  Go to the Risk of Release field and select Low (or Medium or High, if
appropriate).
b) Assess the consequences of release. Your assessment of the consequences will
largely depend on site-specific factors such as the characteristics of the area
surrounding the facility; you might rate the consequences as high if, for example, a
residential area and a school are located within the  vulnerable zone, or medium if a
few members of the public are likely to be found within the zone. Go to the
Consequences of Release field and select Low, Medium, or High.
c) Assess the overall risk of a release. Your assessment will depend on how you
rated the risk and consequences of a release. A combination of low risk of release and
high consequences might be considered a medium risk overall. Go to the Overall Risk
of Release field and select Low, Medium, or High.
d) If desired, enter comments on your screening analysis and choice of risk levels.
Click on Comments. Record your comments on the new screen that appears.  You
might want to record information on the potentially affected population within the
vulnerable zone, for example, or discuss factors that might make the worst-case
release would be very unlikely.  When you are finished, click on Save.
e)  From the Record menu, click on Save.

4) Reevaluate vulnerability with a more likely scenario.

a) From Record, select Add for a new Screenings and Scenarios screen for
acrylonitrile.

b) Select the Scenario radio button.
c) Type a different release quantity into the Maximum Quantity field (e.g., assume

no more than 10,000 pounds could be released from the tank before the release is
stopped).

d) Type 2500 into the Diked Area field (the diked area does not change).
e) Select Physical State Liquid and choose Ambient temperature.
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f)  Select Terrain and choose Open.
g) Change the wind speed and atmospheric stability to reflect different conditions

(e.g., use 10 miles per hour wind speed and D stability).  Click on Calculate.
(CAMEO gives a distance of 0.2 miles for a release of 10,000 pounds with a wind
speed of 10 miles per hour and D stability.)

5) Reevaluate risk and its impacts on community planning efforts.

a) Assess the risk of release.  This assessment will depend on site-specific conditions.
A scenario that is more likely than the worst-case release still may be quite unlikely,
and the risk of release may be low. If the scenario chosen is based on a particular
type of release that is known to be a problem under the conditions existing at this site,
the risk of release may be considered medium or high.  Go to the Risk of Release field
and select Low, Medium, or High.
b) Assess the consequences of release. This assessment will be site-specific. If the
vulnerable zone does not extend outside the facility boundaries, consequences would
be considered low. If some members of the public might be affected, consequences
might be rated medium.  Go to Consequences of Release and select Low, Medium, or
High.
c) Assess the overall risk of a release, based on the assessment of risk and
consequences of the release.  Go the Overall Risk of Release and select Low,
Medium, or High.
d) If desired, enter comments on your scenario analysis and choice of risk levels.
Click on Comments. Record your comments on the new screen that appears.  You
might want to record information on the basis of your choice of scenario (e.g.,
perhaps it is based on an actual release), the potentially affected population within
the vulnerable zone, or other factors affecting the risk assessment.  When you are
finished, click on Save.
e) From the Record menu, click on Save.

 Lunch (12:00-1:00 pm)
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HAZARDS ANALYSIS AND
CAMEO

Demonstration and Hands-on
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Now you have an idea of what a hazards analysis is.  As you remember, the
steps in the hazards analysis are hazards identification, vulnerability analysis,
and risk analysis.  In this session, we will see how CAMEO can be used to
conduct a hazards analysis.

HAZARDS ANALYSIS
PROCESS

(Slide with three boxes)
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In this session, you will learn about using CAMEO to conduct a hazards analysis.
Several modules can provide information that is important to hazards
identification, the first step in hazards analysis.  This information includes the
identities, locations, quantities, and hazards of chemicals in the area.
• The Chemical Identification Module, which you learned about in an earlier

session, includes a large number of chemicals.  A Response Information Data
Sheet, or RIDS, is provided for most chemicals.

• The Facilities Module is provided to keep track of information about facilities
where hazardous chemicals are handled or stored.

• The Chemicals in Inventory/Transit Module is used to maintain information
about inventories of hazardous chemicals at facilities in the Facilities
database.  Information submitted under EPCRA may be stored in the CAMEO
database.  Information on quantities stored and storage locations is included.

• For vulnerability analysis, the second step in hazards analysis, the CAMEO
Screening and Scenarios Module, discussed in an earlier session,  includes
procedures from the Technical Guidance for Hazards Analysis, or “Green
Book,” discussed in the previous presentation.  These procedures are used to
carry out the calculations for the vulnerable zone.  ALOHA, the air dispersion
modeling component of CAMEO, also can be used to produce a “footprint”
representing the vulnerable zone.  ALOHA takes many more factors into
account and carries out much more complicated calculations than the Green
Book method.

HAZARDS ANALYSIS AND
CAMEO

● Hazard Identification
- Chemical Information Module

- Facilities Module

- Chemicals in Inventory/Transit Module

● Vulnerability Analysis

- Screening and Scenarios Module (Green
Book)

- ALOHA

● Risk Analysis
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• For the risk analysis, the final step in hazards analysis, CAMEO’s Screening
and Scenarios module provides a framework for developing qualitative
estimates of risk.
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Script Notes for Session IV

Day Three

IV. Advanced Functions in CAMEO (1:00 - 1:45 pm)

Learning Objectives:  To show the class more advanced functions available in CAMEO.
These functions include developing and printing reports and navigating in CAMEO using
the Windows menu.

The instructor will use a combination of demonstration, and lecture for this session.

•  Reports in CAMEO
•  Windows menu
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Detailed Script for Session IV

Day Three

IV. Advanced Functions in CAMEO (1:00 - 1:45 pm)

1) Generating Reports
This session you will learn how to generate reports in CAMEO.  CAMEO allows you to
create reports containing detailed information on records in every CAMEO module.
Report information varies across modules and across facilities.

To access the Reports menu item:

Open any CAMEO module by selecting it from the File menu and clicking on it.

I am going to select the Facilities module.  Once I have opened the Facilities module, I
can create a report about the specific facility that is highlighted.  To create a report
containing information from the active module:

Select Reports from the File menu.

This screen shows the Report Selection dialog box.  We can choose from a variety of
reports.  To show the report on Chemicals in Inventory/Transit by Facility and Chemical,
follow these steps.

Highlight the desired report by clicking on it.

We are now faced with a few choices.  We can choose to create a report in column
format, (the (C) behind the report indicates the column format).  We can display the
report on the screen, send it to the printer, or write the report to a text (.txt) file that we
can save and look at later.  Let's generate a report and display it on the screen.  To do
this:

Click once on the Chemicals in Inventory/Transit by Facility and Chemical (C)
report option.  Click on the Screen button and then click on the Run button.

This slide shows page one of the report.  You can use the buttons on the right-hand side
of the report to move between the pages of the report and zoom in and out.  To exit:

Click on the OK button then on the Cancel button in the Report Selection dialog
box.

The Reports menu item is a useful tool.  Each module of CAMEO can generate different
reports.
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I am going to demonstrate how to create a more specific report from within the Facilities
module.

Go to the View menu and select Find All by clicking on it.  In the "Select Field To
Search In:" box, select “Location City.”  In the "Enter Value To Search For:" box
type Haymarket.  Now, click on the set button.

As you can see, we have limited the list of facilities to those located in Haymarket.  Now,
we can obtain a report telling us the chemicals in inventory at the Facilities in Haymarket.

Click on Reports in the File menu.  Select the report Chemical in
Inventory/Transit by Facility and Chemical (C).  Next, click in the box "Print all
Records in View."

We will print this report to the screen.

Click on the Run button.

We now have a report on our screen telling us the facilities in Haymarket and the
chemicals that they store.

Click on the OK button then on the Cancel button in the Report Selection dialog
box.  Click on Clear Find All in the View menu to access other modules.

Take some time to look at the different reports you can create in each module.  Also, see
if you prefer columnar reports in certain instances.

2) Windows Menu
The Windows menu in CAMEO allows you to navigate between modules you have used
recently.  This functions somewhat like a bookmark system.  I will demonstrate how this
navigation tool works:

Select the Facilities module by clicking it from the File menu.  Highlight the
Green Valley Water Facility, click on Show Links from the Record menu, and then
highlight Toxic Release Inventory.

Let's say I want to get back to the facilities module.  The Windows menu keeps a history
of active windows, allowing you to quickly and easily return to recently used modules.

To get to the last active Facilities module, I can either:

Click on Previous in the Windows menu.  Or, I can go to the Windows menu and
select Facilities from the list at the bottom of the menu.
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You can also use the Windows menu to close all active windows by:

Clicking on the Close All Windows menu item.
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 Script Notes for Session V
 

 

 Day Three
 

 VII.  System Administration (2:00-3:00 pm)
 

 Learning Objectives:  To introduce students to basic system administration and
management concepts and understand the importance of good system management, how
to list and describe the seven elements of good system management, and the seven
elements as they apply to specific pieces of CAMEO.
 

 A PowerPoint presentation will accompany the trainer’s lecture for this session.
 

 The seven (eight) elements of good system administration
•  Planning
•  Building
•  Using
•  Managing
•  Maintaining
•  Training
•  Reviewing
•  Researching
 

 Relating the seven elements to specific pieces of CAMEO
•  Hardware and software requirements
•  Looking to the future
•  Using MARPLOT and CAMEO
•  Administration functions

Evaluating use
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Welcome to the session on system administration.  The term ‘System
Administration’ can be confusing, but it’s really not so hard to understand.
Consider an organization like EPA, a state emergency response commission, or
a local fire department that can respond to hazardous materials incidents.  To
have an effective unit, branch, or division within the organization, the staff need
to be managed and administered properly.  An organization is a team with a
mission and if one person doesn’t have an idea how he or she fits in or doesn’t
know his job, the team can be less effective and even stymied.  Particularly in
emergency response and planning, teamwork is critical.  Computer information
systems are tools in an organization. Like staff, computer systems must fit into
the overall goal of the organization.  Consequently, computer systems must be
managed and administered properly so that they are effective and optimized
tools for the staff.  Whose job is it to perform system administration?  Well, of
course a system administrator is prime, but such an administrator cannot do his
job without substantial input from the front-line users and staff.  An organization
without a formal system administrator depends even more on staff input.  So take
a moment to learn about system administration for CAMEO and take it to heart.

System Administration
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If there was a goal of this session, what would it be?  It would be to understand
basic system management concepts and to best use the information systems,
like CAMEO, in emergency response and planning.

Think about how exactly you are using your system.  Is it the best you can do?
Are there other tasks you can accomplish with just a little bit more imagination
and better management and organization?

You want to optimize your use of CAMEO.  If you already use CAMEO, do you
just use Codebreaker and RIDS?  Have you ever attempted to put other
information in?

Computer systems can be frustrating, a little education and organization can go a
long way to make you (and others) want to use your system.

Purpose

● To understand basic system
management concepts

● To encourage/optimize your use of
information systems (e.g., CAMEO)
within your emergency response and
planning community
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The basic principle in system administration is easy.  You are working for a single
customer - the community so a system that meets your emergency response and
planning needs DOES satisfy the community’s needs.  If your system is well
managed, operated, and maintained, your system will do what you want it to,
when you want it to.

Conversely, a system that does not meet your needs, DOES NOT satisfy the
Community’s needs.  In the end, if your system doesn’t work, it’s to the detriment
of the community.

Basic Principles

● A system that meets your emergency
response and planning needs DOES
satisfy the community’s needs.
» If your system is well managed, operated,

and maintained, your system will do what
you want it to, when you want it to

● A system that does not meet your
needs DOES NOT satisfy the
community’s needs.
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A Good System is a set of computer tools that does what you want it to when you
want it to and gives you the right information.

A Good Cameo System is one that gives you answers in a timely manner to
questions such as

“List all of the facilities that store the chemical paraquat” , etc.

What’s a Good System?

● Set of computer tools that manage
accurate information

● Set of computer tools that provides
timely access to accurate and useful
information
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Here are the elements that you need to make a good system.  They include
planning the system, building the system, using, managing, and maintaining the
system, training on the system, and periodic reviewing of the system.  Let’s
explore each one of these elements.  But first, what are the benefits of a good
system?

A Good System - The Big
Picture

Good System

Plan

Build

Use

ManageMaintain

Train

Review
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Here are a few benefits of good system administration of an information
management system.

The amount of information available to support emergency response and
planning is growing.  Title III has brought the amount and accessibility of the
information forward.  A good information management system can further this
access.  With greater access and control over this information you become a
valuable asset to your department.  Remember, you can answer questions that
would have taken a long time to answer if at all?

Information management systems give you entry into a world of new analysis.
For example, Which facilities store ammonia and chlorine?  You can focus your
efforts by defining high risk areas.

A good information management system provides new ways to view and think
about the information.  This could be as simple as a new report format - or
complex as access to better hazards analysis or air modeling.

Additionally, sharing information is easier among local departments - LEPCs, fire
department, dispatch.

The ultimate benefit is improved safety.

Benefits

● Greater access to information

● Better analysis of information

● New ways to use and control
information

● Opportunities to share information with
others

● Ultimate goal - Improved Safety
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A good system doesn’t just happen.  You first have to plan it.

Good System

Plan

Build

Use

ManageMaintain

Train

Review
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Planning starts with a system plan.  Such a plan lists the goals and objectives of
the system.  Much of this has already taken place with CAMEO.  For example,
the developers of CAMEO understood the need to support emergency response
and planning functions by providing:
•  detailed response information on hazardous chemicals
•  hazards analysis tools
•  mapping tools

Let's assume you were planning to develop additional emergency response or
planning tools to augment CAMEO.  In planning, you must create a system team
and outline responsibilities.  You must be realistic about the expectations you
have for each team member.  Such a team should document existing hardware
and software capabilities and document information needs and sources.

Create a System Plan

● List the goals and objectives of the new
system or the system to be improved

● Create a system team and outline
responsibilities

● Document existing hardware and
software capabilities

● Document information needs and
sources
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If you plan poorly, you will not be able to recall specific information in a timely
manner.  Also, you may also not be able to use system capabilities as expected
or perform a function you thought the system did.

Examples of Bad Planning

● Not being able to recall specific
information from your system in a timely
manner

● Not being able to use system
capabilities as expected

● Learning that your system does not
perform a function you thought it did
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After planning you can build a system.

Good System

Plan

Build

Use

ManageMaintain

Train

Review
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In building such a system to augment CAMEO, you would:
• implement the system plan
• designate responsibilities and maintain a schedule for building the system
• consult with and prepare the ultimate users for the system
• inspect and test the system and
• use the system a lot to identify all bugs and aspects that don’t live up to

desired capabilities.

Build Your System

● Implement the system plan

● Designate responsibilities and maintain
a schedule

● Consult and prepare users

● Inspect/Test the system

● Use the system - a lot
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In the midst of building a system, expect some pitfalls.  Expect the unexpected
like when development funds don’t come or a team member leaves.  Maybe an
upper management person does not understand computer issues and is resistant
to the new system.  Also, expect resistance from the uninformed.  Remember
while you may be wondering about an important capability such as ‘What would it
take to make it model river spills’, your colleague or manager may be wondering
‘What is a hard drive?’.

Pitfalls

● Expect the unexpected

● Expect resistance from the uninformed

● By the time you make ends meet, they
move the ends
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After building a system, just like after building a house, you have to use,
maintain, and manage the system.  These elements are critical for either a new
system or an existing system like CAMEO.

Good System

Plan

Build

Use

ManageMaintain

Train

Review
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To assure effective and appropriate use of CAMEO or any system, you need to
make sure you develop and follow good system operating procedures.
Procedures should exist for standard uses of the system, for data entry and
retrieval, for system startup and shutdown, and for system backup.  The
procedures should be easily available in something like a notebook to encourage
its use.  A system contact list should be available to specify users and particular
experts to call about certain problems.  Also, it is good practice to develop a
system log book.  Such a log book is like keeping records for your house and it
supports the accountability of the system.  You might maintain records on an
assortment of topics including the number and location of backup copies,
hardware/software inventory, data entry status, and training status.

Use, Manage, and Maintain

● Develop good system operating
procedures
» standard uses

» data entry and retrieval

» system startup and shutdown

» system backup

● Develop system contact list

● Develop system log books for
maintaining records
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A well used, managed, and maintained system makes you more productive.
Using your system leads to an increase in system knowledge, skill building, and
adds credibility to the utility of the system and investment.  Adding new
capabilities increases the application of the system to your real life problems.
Virus scanning programs protect your investment.  And imagination and
innovativeness never hurt production.

Being More Productive

● Use your system at every opportunity

● Add new capabilities
» updates

» telecommunications

» other productivity tools

● Protect your investment
» protect yourself against viruses and “happy

fingers”

● Be imaginative and innovative
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Next is training.

Good System

Plan

Build

Use

ManageMaintain

Train

Review
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Here are some questions to consider in providing a training program.

• What good is an excellent computer system if no one is trained to use it?
• Are all of the functions of the CAMEO/ALOHA/MARPLOT really necessary for

everyone to learn?
• Should you have different levels of training?

! Data entry
! Infrequent but important users

Training

● What good is an excellent computer
system if no one is trained to use it?

● Are all of the functions of
CAMEO/ALOHA/MARPLOT really
necessary for everyone to learn?

● Should you have different levels of
training?
» Data entry

» Infrequent but important users
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Here are some general guidelines for developing or implementing a training
program.
• Start with a realistic approach
• Get organizational and management commitment
• Focus on timeliness, appropriateness, and adequacy of training
• Develop a strategy to maintain, verify, and improve knowledge and skill

acquisition and
• Nurture a learning culture within user community

Training

● Start with a realistic approach

● Get organizational and management
commitment

● Focus on timeliness, appropriateness,
and adequacy of training

● Develop a strategy to maintain, verify,
and improve knowledge and skill
acquisition

● Nurture a learning culture within user
it
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Manuals are the first line on training.  Read and use them.

Read and Use the Manuals

Have your read the manual?
.....No?.....OK, look on page
16 and the last paragraph
on the page...
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Part of training is to make sure you have access to user support.  User support
can be a training tool.  For CAMEO, technical support can be obtained from the
National Safety Council and EPA regions.  User groups share CAMEO
information and problems.  Here are a few user groups.  Newsletters, such as
CAMEO today from the NSC also have excellent suggestions and
recommendations for users.  Finally, periodicals may have some information to
further inform your users.

User Support

● Technical support
» National Safety Council

» EPA Regions

● User Groups
» New England

» EPA Region 5

» Southern California

● CAMEO Today

● Periodicals
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Finally, we come to the last element, review of the system.

Good System

Plan

Build

Use

ManageMaintain

Train

Review
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Review and assessment evaluates how well your system meets your needs
and how good it is.  For example, has the system performed as expected
during emergencies?  During planning or non-emergencies? Where did any
breakdown occur?  Hardware?  Software?  Users?  Functions? Are users
performing as expected with the system? Are you able to access accurate
information in a timely manner?

Answers to these questions should come from all users or a sampling of all
users.  A survey or someone could be delegated to collect such information.
Responses should be evaluated and valued so that proper system changes can
be made.

Review and Assessment

● Ask questions about performance

● Periodically document your answers to
such questions

● Refine and/or modify system as needed
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So these are the elements of good system administration.  The elements are
applicable to CAMEO or other systems that support and further emergency
planning and response.  Properly administer these elements and you ...

SYSTEM

Plan

Build

Use

ManageMaintain

Train

Review
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Youhave conquered the system!

I’ve finally
conquered

the
SYSTEM!
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Script Notes for Session VI

Day Three

VI.  Test (3:00-4:30 pm)

Learning objectives:  To give the class the opportunity to test themselves on their comprehension
of both the more advanced CAMEO skills and the basic skills learned Day One and Two.

Class members will work together in small groups (2-4 people) to answer the exercises, which
will be based on those provided by EPA/CEPPO.  Forty-five minutes will be allowed for the
class to complete the exercises (with assistance from trainer(s), where necessary), with an
additional fifteen minutes allowed for discussion of the answers and any additional questions the
class may have.

Problem Set 3

I. You are dispatched to a 4 story laboratory complex that employs approximately 500
persons, for an undefined type of "spill."

The temperature is 68 degrees, winds are light and variable and it is a sunny day with few clouds
in the sky.

On arrival, you are met by one of the lab techs who leads you to a second floor lab where a 1
gallon container has been knocked from a lab bench.  The lab tech cannot identify the
material in the bottle as it his first day on the job.

Your recon crew reports that 1 gallon of an unknown liquid is on the floor along with a quantity
of a yellow crystalline material.  You can make out the following information on the
handwritten label on the container:  "Melinite CL 10305".  There is a red and white
sticker on the bottle, but because of the damage, it is not readable.

The lab hood is operating and the liquid substance appears to be evaporating.

A. Identify the substance.

Answer:  Picric Acid (wet)

B. Is this substance explosive?

Answer:  Yes, the substance is explosive.

C. What are the health hazards associated with this substance?
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Answer:  Contact may cause burns to the skin and eyes.  Fire may produce irritating or
poisonous gas.  Run-off may cause pollution.

D. What personal protective equipment should be worn?

Answer: Wear clothing and eye protection to prevent contact with the skin.

E. What steps should you take to clean up the substance?

Answer:  Wet spilled material before picking it up.  Do not attempt to sweep up dry
material.

II. You are a member of the Prince William County Local Emergency Planning Committee
(LEPC).  It is your job to evaluate the hazards posed to the local community by the M &
S Chemicals Facility.

A. Identify the location of the facility.

1. What town is the facility located in within Prince William County?

Answer:  Haymarket

2. What does the facility produce?

Answer:  Alkalies and Chlorine

B. What chemical is listed on the Tier II Chemical Inventory for the M & S
Chemicals facility?

Answer:  Chlorine

1. How much of each chemical is stored on-site?

Answer:  An average of 2,000 pounds

2. Where are the chemicals stored?

Answer:  Section C Storage Yard

3. How are the chemicals stored?

Answer:  Above ground tank

C. Does the facility transport chemicals within Prince William County?
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Answer:  No

D. You decide to use the Screenings and Scenario module in CAMEO to determine
the best way to respond to an incident at the M & S Chemicals facility.

1. Data Entry:

a) Add a new record (Scenario 1) containing the following information:
3,000 pounds of pure gas; wind speed of 3.35 miles/hour; duration of
ten minutes; and stability F.  Calculate and note the vulnerability zone
radius for this scenario.

b) Scenario 2 contains the following information: 3,000 pounds of pure gas; wind
speed of 3.35 miles/hour; duration of ten minutes; and stability B.  Calculate and note the
vulnerability zone radius for this scenario.

2. Is there a difference in the size of the vulnerability zone radius based on
the difference in stability class, (F being stable and B being unstable)?

Answer:  Yes.  With greater stability, the vulnerability zone is larger.  With less
stability, the vulnerability zone is smaller (i.e., the vulnerability zones for
Scenario 1 and 2 are >10 miles and 1.2 miles, respectively).

3. How might this information effect the way in which you plan for a
response?

Answer:  Your emergency planning might need to account for the time the facility
experiences stable conditions (middle of the night) and the number of
people potentially exposed at that time.

III. You are a planner for Prince William County, you have been asked to compile summary
information, by town, on the facilities located in the county.  What would the summary
information look like for Haymarket?

Answer:  There are three facilities in Haymarket (Green Valley Water Facility, Adams
Petroleum Refinery, and M & S Chemicals).  Green Valley Water Facility stores an
average of 1,000 pounds of chlorine, Adams Petroleum Refinery stores an average of
8818 pounds of Naptha, and M & S Chemicals stores an average of 2,000 pounds of
chlorine.  There are approximately 3,000 pounds of chlorine stored in these facilities and
8,818 pounds of Naptha.
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Answers to Problem Set 3

I. You are dispatched to a 4 story laboratory complex that employs approximately 500
persons, for an undefined type of "spill."

The temperature is 68 degrees, winds are light and variable and it is a sunny day with few
clouds in the sky.

On arrival, you are met by one of the lab techs who leads you to a second floor lab where
a 1 gallon container has been knocked from a lab bench.  The lab tech cannot identify the
material in the bottle as it his first day on the job.

Your recon crew reports that 1 gallon of an unknown liquid is on the floor along with a
quantity of a yellow crystalline material.  You can make out the following information on
the handwritten label on the container:  "Melnite CL 10305".  There is a red and white
sticker on the bottle, but because of the damage, it is not readable.

The lab hood is operating and the liquid substance appears to be evaporating.

A. Identify the substance.

Answer:  Picric Acid preferred chemical name (melinite synonym)

Steps to follow:
a)  Go to the Chemical Information Module, by clicking on Chemical Information

from the File menu.
b)  Go to the View menu and click on Find.
c)  Enter Melnite in the "Enter value to search for:" box.  Note, the record is not

found.
d)  Instead, enter Mel (because you suspect misspelling/misreading the label) in

the "Enter value to search for:" box.  Check to see that you are searching on
Chemical Name in the "Select field to search in:" box.  Click on the Find
button.

e)  Based on the label, you can scroll down and find chemical information
records for Melinite.

B. Is this substance explosive?

Answer:  Yes, the substance is explosive.

Steps to follow:
a)  Highlight the record for Melinite by clicking on it with the cursor.
b)  Press enter to view the detailed record for Melinite.
c)  Look at the field for the DOT Label on the first page of the detailed chemical

information record.
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C. What are the health hazards associated with this substance?

Answer:  Contact may cause burns to the skin and eyes.  Fire may produce
irritating or poisonous gas.  Run-off may cause pollution.

Steps to follow:
a)  Click on the RIDS button in the detailed chemical information record for

Melinite.
b)  Click on the Health Hazards radio button to view the health hazards for

Melinite.

D. What personal protective equipment should be worn?

Answer: Wear clothing and eye protection to prevent contact with the skin.

Steps to follow:
a)  Click on the RIDS button in the detailed chemical information record for

Melinite.
b)  Click on the Protective Clothing radio button to view the health hazards for

Melinite.

E. What steps should you take to clean up the substance?

Answer:  Wet spilled material before picking it up.  Do not attempt to sweep up
dry material.

Steps to follow:
a)  Click on the RIDS button in the detailed chemical information record for

Melinite.
b)  Click on the Non-fire Response radio button to view the health hazards for

Melinite.

II. You are a member of the Prince William County Local Emergency Planning Committee
(LEPC).  It is your job to evaluate the hazards posed to the local community by the M &
S Chemicals Facility.

A. Identify the location of the facility.

1. What town is the facility located in within Prince William County?

Answer:  Haymarket
Steps to follow:
a)  From the File menu, click on Facilities to enter the Facilities Module.
b)  Scroll down until you have highlighted M & S Chemicals.
c)  Use the arrow keys to scroll across the record for M & S Chemicals.
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d)  Look in the field "City Location" to determine where the facility is
located.

2. What does the facility produce?

Answer:  Alkalies and Chlorine

Steps to follow:
a)  From the Facilities Module, highlight the record for M & S Chemicals

and press enter to view the detailed record for the facility.
b)  Look in the SIC Codes: field on Page 2 of the detailed record.

B. What chemical is listed on the Tier II Chemical Inventory for the M & S
Chemicals facility?

Answer:  Chlorine

Steps to follow:
a)  From the detailed record for the M & S Chemicals facility, click on the View

Menu and highlight the Tier II Form.  You should now be looking at the Tier
II Form for M & S Chemicals.

b)  Click on the Chemical Information Form button to view detailed information
about the chemicals at the M & S Chemicals facility.

1. How much of each chemical is stored on-site?

Answer:  An average of 2,000 pounds

Steps to follow:
a)  From the File menu, select the Chemicals in Inventory/Transit

Module.
b)  Find the record for M & S Chemicals.
c)  Highlight the record for M & S Chemicals by clicking on it.
d)  Press enter to view the detailed record for M & S Chemicals.
e)  Look in the Amount Totals fields.

2. Where are the chemicals stored?

Answer:  Section C Storage Yard

Steps to follow:
a)  From the File Menu go to the Storage Locations module.
b)  Locate the record for Chlorine stored at M & S Chemicals, highlight

the record, and press enter to view the detailed storage location
record.
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3. How are the chemicals stored?

Answer:  Above ground tank

Steps to follow:
a)  From the File Menu go to the Storage Locations module.
b)  Locate the record for Chlorine stored at M & S Chemicals, highlight

the record, and press enter to view the detailed storage location
record.

C. Does the facility transport chemicals within Prince William County?

Answer:  No

Steps to follow:
a) From within the facility record for M & S Chemicals, select Routes from the

File menu.
b) Click on James Madison Highway (US HWY 15) from the Route Information

menu.
c) Look in the County field.

D. You decide to use the Screenings and Scenario module in CAMEO to determine
the best way to respond to an incident at the M & S Chemicals facility.

1. Data Entry:

a) Add a new record (Scenario 1) containing the following information:
3,000 pounds of pure gas; wind speed of 3.35 miles/hour; duration of
ten minutes; and stability F.  Calculate and note the vulnerability zone
radius for this scenario.

Steps to follow:
a)  From within the facility record for M & S Chemicals, select

Show Links from the Records menu.
b)  Click on Screenings and Scenarios in the pull down list.
c)  From the Record menu, select Add by clicking on it.
d)  Enter the information listed above in the appropriate blanks.
e)  Once you’ve entered the information for Scenario 1, press the

Calculate button.

b) Scenario 2 contains the following information: 3,000 pounds of
pure gas; wind speed of 3.35 miles/hour; duration of ten minutes;
and stability B.  Calculate and note the vulnerability zone radius
for this scenario.
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Steps to follow:
a)  Since the only difference from Scenario 1 is the Stability Class,

simply pick the appropriate letter from the Stability Class pull
down menu.

b)  Once you’ve entered this information for Scenario 2, press the
Calculate button.

2. Is there a difference in the size of the vulnerability zone radius based on
the difference in stability, (F being stable and B being unstable)?

Answer:  Yes.  With greater stability, the vulnerability zone is larger.
With less stability, the vulnerability zone is smaller (i.e., the vulnerability
zones for Scenario 1 and 2 are >10 miles and 1.2 miles, respectively).

3. How might this information effect the way in which you plan for a
response?

Answer:  Your emergency planning might need to account for the time the
facility experiences stable conditions (middle of the night) and the number
of people potentially exposed at that time.

III. You are a planner for Prince William County, you have been asked to compile summary
information, by town, on the facilities located in the county.  What would the summary
information look like for Haymarket?

Answer:  There are three facilities in Haymarket (Green Valley Water Facility, Adams
Petroleum Refinery, and M & S Chemicals).  Green Valley Water Facility stores an
average of 1,000 pounds of chlorine, Adams Petroleum Refinery stores an average of
8818 pounds of Naptha, and M & S Chemicals stores an average of 2,000 pounds of
chlorine.  There are approximately 3,000 pounds of chlorine stored in these facilities and
8818 pounds of Naptha.

Steps to follow:
a)  From the File Menu select the Facilities Module.
b)  From the View menu select Sort.  View facilities in order by City-Location.
c)  Click on OK to sort the data.
d)  Once you know the Facilities located in Haymarket, go to the File menu and select
Chemicals In Inventory/Transit.
e)  Scroll through the records using the blue and red arrow keys to determine the
chemicals and amounts stored at the facilities.
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Script Notes for Session IX

Day Three

IX. Questions and Answers (4:30-5:00 pm)

A final opportunity for students to ask any questions about the material covered or about
potential problems or applications of CAMEO.


	After accessing the Find menu item, enter “methyl iso” in the search entry and click Find.

